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Preface

This document describes how to configure and manage Oracle Enterprise Scheduler.

Oracle Enterprise Scheduler provides the ability to run different job types, including: Java, PL/SQL, and binary scripts, distributed across the nodes in an Oracle WebLogic Server cluster. Oracle Enterprise Scheduler runs these jobs securely, with high availability and scalability, with load balancing and provides monitoring and management through Oracle Enterprise Manager Fusion Middleware Control.


Audience

This document is intended for administrators of Oracle Enterprise Scheduler.


Documentation Accessibility

For information about Oracle's commitment to accessibility, visit the Oracle Accessibility Program website at http://www.oracle.com/pls/topic/lookup?ctx=acc&id=docacc.


Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For information, visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=info or visit http://www.oracle.com/pls/topic/lookup?ctx=acc&id=trs if you are hearing impaired.


Related Documents

For more information, see the following documents in the Oracle 11g Fusion Middleware documentation set:

	
Oracle Fusion Middleware Developer's Guide for Oracle Enterprise Scheduler
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monospace

	
Monospace type indicates commands within a paragraph, URLs, code in examples, text that appears on the screen, or text that you enter.
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1 Introduction to Oracle Enterprise Scheduler


This chapter provides a general introduction to Oracle Enterprise Scheduler and its administration tasks. With Oracle Enterprise Scheduler, you can define, schedule and run jobs, or units of work done on an application's behalf.

Oracle Enterprise Scheduler is installed with a product that embeds it to provides scheduling services. You typically won't have to install Oracle Enterprise Scheduler.

This chapter includes the following topics:

	
Introduction to Administering Oracle Enterprise Scheduler


	
Basic Tasks for Configuring and Managing Oracle Enterprise Scheduler






1.1 Introduction to Administering Oracle Enterprise Scheduler

With Oracle Enterprise Scheduler, you can define, schedule and run jobs. A job is a unit of work done on an application's behalf. For example, you might define a job that runs a particular PL/SQL function or command-line process. You can define a job that executes Java code. Those job types are included with Oracle Enterprise Scheduler:

	
Java job type for executing Java code.


	
Process job type for executing a command-line command.


	
PL/SQL job type for executing functions in Oracle's extension language for SQL.




When you create jobs from these types you associate metadata as a job definition. Through this context-specific metadata, the job does meaningful work on the application's behalf. That metadata can include parameter values the user specifies and values for properties defined by Oracle Enterprise Scheduler. By defining schedules, you can have jobs run when you want them to (such as at off-peak times). You can also specify constraints that prevent jobs from running when you don't want them to. By creating job sets, you can group multiple jobs into batches whose jobs run either simultaneously or in a sequence.

Oracle Enterprise Scheduler provides tools with which you can monitor the system. For example, you might want to get a snapshot of current and pending job requests, or see how the system is performing under load. You can also get logs and the status of service components.

You can perform each of these tasks, from submitting jobs to monitoring the system, with the Scheduling Services pages of Oracle Enterprise Manager Fusion Middleware Control Console. For a more detailed list of tasks, see Section 1.2, "Basic Tasks for Configuring and Managing Oracle Enterprise Scheduler".






1.2 Basic Tasks for Configuring and Managing Oracle Enterprise Scheduler

You administer Oracle Enterprise Scheduler with the Oracle Enterprise Manager Fusion Middleware Control Console (Fusion Middleware Control). There, the Scheduling Service home page provides an overview of scheduler component status, top running and completed scheduled job requests, as well as a performance summary of scheduled job requests. Other Scheduling Service pages provide a user interface for performing the tasks described in this section (and many others).

The following provides a summary of steps you might take to get set up use the service:



1.2.1 Set Up and Configuration

	
Create a domain and configure a cluster. Oracle Enterprise Scheduler is installed by a product that includes it as a service to manage schedules. However, it's possible that the embedding product didn't configure domains that support Oracle Enterprise Scheduler for deploying. See Section 3.2.


	
Configure a request processor and request dispatcher. A job request processor is bound to a particular Oracle Enterprise Scheduler server, and is responsible for allocating threads for job requests. A job request dispatcher polls for job requests. See Section 3.4.


	
Start the instance. See Section 3.6.









1.2.2 Creating Jobs to Run

	
Create job definitions. You define and manage job definitions that specify values specific to the request at hand. See Section 5.2.1.


	
Create schedules. You can define a schedule for managing the execution of job requests, work assignments, work shifts and purge policies. You can also create schedules on the fly when creating a request. See Section 4.2.1.2, Section 4.2.3 and Section 5.3.3.


	
Create and submit job requests. A job request pulls together a job definition with a schedule on which the job will run. See Section 4.2.1.


	
Create a purge policy. Purge policies allow you to define the conditions for retaining and purging job requests associated with a request processor. See Section 4.3.









1.2.3 Bundling Jobs and Refining Their Work

	
Create job sets. With job sets, you can bundle jobs into groups in which the jobs run at the same time or in a sequence. See Section 5.2.2.


	
Define restrictions with incompatibilities. Incompatibilities specify which jobs shouldn't run at the same time, along with the conditions under which they are incompatible. See Section 5.2.3.


	
Define restrictions with work assignments. Work assignments define rules under which jobs can be processed, along with windows of time in which they can run. See Section 5.3.1.









1.2.4 Monitoring the System

	
Monitor the system. You can monitor job requests, system performance, and system status. You can also get logs for job requests and the system. See Chapter 6, "Monitoring Oracle Enterprise Scheduler".














2 Getting Started Managing Oracle Enterprise Scheduler


This chapter describes how to access Oracle Enterprise Manager Fusion Middleware Control and Oracle Enterprise Scheduler configuration, monitoring, and management tasks.

This chapter includes the following topics:

	
Logging into Oracle Enterprise Manager Fusion Middleware Control Console


	
Navigating to Oracle Enterprise Scheduler Administration Tasks


	
The Scheduling Service Home Page


	
Logging Out of Oracle Enterprise Manager Fusion Middleware Control






2.1 Logging into Oracle Enterprise Manager Fusion Middleware Control Console

You can administer Oracle Enterprise Scheduler by using the Oracle Enterprise Manager Fusion Middleware Control. This section describes how to start and log in to the console.

To log in to Oracle Enterprise Manager Fusion Middleware Control Console:

	
Use Internet Explorer 7, Mozilla Firefox 2.0.0.2, or Firefox 3.0.x to access the following URL:

http://host_name:port/em

where host_name is the name of the host on which Oracle Enterprise Manager Fusion Middleware Control Console is installed and port is a number that is dynamically set during installation. This port is typically 7001, but is the HTTP port associated with the Oracle HTTP Server. For environments in which the SSL port was enabled during configuration, the default port is 7002.


	
Enter weblogic/password and click Login.

where:

	
weblogic is the default administrator user name for Oracle Enterprise Manager Fusion Middleware Control. You can change this during installation. You can also add new administrator users using the WebLogic console.


	
password is the password you entered during installation.




The Accessibility Preference dialog appears the first time you log in. If you want, you can select to not display this option again.


	
Select an appropriate action and click Continue.

The farm home page is displayed. From there, you can navigate to the Scheduling Service.









2.2 Navigating to Oracle Enterprise Scheduler Administration Tasks

The Scheduling Service menu of Fusion Middleware Control or Cloud Control provides access to administrative tasks for Oracle Enterprise Scheduler.

To navigate to Oracle Enterprise Scheduler pages in Fusion Middleware Control or Cloud Control:

	
From the navigation pane, expand the farm and then Scheduling Services, and select the Oracle Enterprise Scheduler component.

[image: ESS component under the Scheduling Services menu.]
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The Scheduling Service home page displays. See Section 2.3 for further information about the contents of the home page.


	
Select the Scheduling Service menu.

[image: The Scheduling Service menu.]
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The Scheduling Service menu displays the following options.


	Menu Option	Description
	
Home

	
Displays the Scheduling Service home page. For more information about the contents of this page, see Section 2.3.


	
Control

	
Displays the following options:

	
Start Up: This option runs the Oracle Enterprise Scheduler server. For more information, see Section 3.6.


	
Shut Down: This option shuts down the Oracle Enterprise Scheduler server. For more information, see Section 3.6.





	
Logs

	
The View Log Messages option displays the Log Messages page for viewing the contents of event log files. See "Managing Log Files and Diagnostic Data" chapter in Oracle Fusion Middleware Administrator's Guide for more information.

The log files are stored in the following directories:

	
DOMAIN_HOME/servers/SERVER_HOME/logs


	
DOMAIN_HOME/servers/SERVER_HOME/logs/apps


	
DOMAIN_HOME/servers/SERVER_HOME/logs/owsm/msglogging/diagnostic.log


	
DOMAIN_HOME/servers/SERVER_HOME/sysman/log/emoms.log





	
Job Requests

	
Displays the following options:

	
Search Job Requests: Allows you to search for job requests according to particular parameters. For more information, see Section 4.2.2.


	
Submit Job Requests: Allows you to submit an execution request for a particular job. For more information, see Section 4.2.1.





	
Performance

	
Displays the following options:

	
Service Summary: This option displays a brief overview of the service performance. For more information, see Section 6.3.1.


	
Current Activity: This option displays current Oracle Enterprise Scheduler activity. For more information, see Section 6.3.2.


	
Historical Reports: This option displays a chart or table depicting previous Oracle Enterprise Scheduler data. For more information, see Section 6.3.3.





	
Request Processor

	
Displays the following options:

	
Start/Stop: This option causes the request processor to start or stop running. For more information, see Section 3.6.


	
Configure: This option displays the Configure Request Processor page, which allows you to enable the request processor, create work assignment bindings and so on. For more information, see Section 3.4.





	
Request Dispatcher

	
Displays the following options:

	
Start/Stop: This option causes the request dispatcher to start or stop running. For more information, see Section 3.6.


	
Configure: This option displays the Configure Request Dispatcher page, which allows you to enable the request dispatcher, manage polling intervals, and so on. For more information, see Section 3.4.





	
Purge Policies

	
Allows you to configure and manage job request purge policies including job request purge criteria, retention criteria and purge policy schedules. For more information, see Section 4.3.


	
Work Allocation

	
Displays the following options:

	
Work Assignments: This option displays the Work Assignments page which allows you to create, edit and delete work assignments. For more information, see Section 5.3.1.


	
Workshifts: This option displays the Workshifts page which allows you to create, edit and delete workshifts. For more information, see Section 5.3.2.


	
Schedules: This option displays the Schedules page which allows you to create, edit and delete schedules for work assignments, workshifts and job request purge policies. For more information, see Section 5.3.3.





	
Job Metadata

	
Displays the following options:

	
Job Definitions: This option displays the Job Definitions page, which allows you to manage job definitions. See Section 5.2.1 for further information.


	
Job Sets: This option displays the Job Sets page, which allows you to create and edit job sets for a given application. For more information, see Section 5.2.2.


	
Incompatibilities: This option displays the Incompatibilities page, which allows you to create and edit incompatibilities for a given application. For more information, see Section 5.2.3.





	
Web Services

	
Displays a page that provides an overview of the web services in the application including web service endpoints and application-level metrics. For more information, see Section 3.9.


	
Security

	
Displays the following options:

	
Application Policies: This option displays the authorization policies that an application relies upon for controlling access to its resources. See Section 3.8 for further information.


	
Application Roles: This option displays the roles used by security aware applications specific to the application. See Section 3.8 for further information.





	
General Information

Target Information

	
Displays general details about the Oracle Enterprise Scheduler instance. Known as Target Information in Cloud Control. For more information, see Section 6.5.















2.3 The Scheduling Service Home Page

Performing Basic Administration Tasks







3 Performing Basic Administration Tasks


This chapter describes how to create and configure the infrastructure on which Oracle Enterprise Scheduler runs. Oracle Enterprise Scheduler is installed with applications for which is provides scheduling services. However, before you begin using Oracle Enterprise Scheduler, you might need to configure the its infrastructure.

This chapter includes the following topics:

	
Introduction to Performing Basic Administration Tasks


	
Creating a Domain That Includes Oracle Enterprise Scheduler Components Using the Configuration Wizard


	
Configuring Perl to Support Process Jobs


	
Configuring Oracle Enterprise Scheduler


	
Searching for Configuration Changes to Oracle Enterprise Scheduler in Cloud Control


	
Starting and Stopping Oracle Enterprise Scheduler Components


	
Managing Application Properties


	
Managing Application and Role Policies


	
Managing Oracle Enterprise Scheduler Web Services






3.1 Introduction to Performing Basic Administration Tasks

Oracle Enterprise Scheduler is installed by a product that includes it in order to provide job scheduling services for the product. However, it might be necessary for you to select deployment of Oracle Enterprise Scheduler explicitly during domain creation, or to configure aspects of Oracle Enterprise Scheduler before you can get the most out of the service.

Among the basic administration tasks you might need to perform are:

	
Creating a domain that includes Oracle Enterprise Scheduler components.


	
Configuring Oracle Enterprise Scheduler by configuring a cluster, request processor, and request dispatcher. While a cluster is optional (Oracle Enterprise Scheduler can run on a single node), a processor and dispatcher are required in order for Oracle Enterprise Scheduler to do its work.


	
Starting and stopping the service instance, its request processors or request dispatchers.


	
Manage application and role policies or service web services.









3.2 Creating a Domain That Includes Oracle Enterprise Scheduler Components Using the Configuration Wizard

Oracle Enterprise Scheduler is installed with products that embed it to support scheduling product jobs. However, during deployment, the embedding product might not have automatically deployed Oracle Enterprise Scheduler. In that case, Oracle Enterprise Scheduler needs to be explicitly selected for deployment during domain creation. When this is the case, you can use the following steps to create a domain that supports Oracle Enterprise Scheduler applications.

	
Change directory to the location of the Configuration Wizard. This is within the home directory of the product that includes Oracle Enterprise Scheduler. Oracle recommends having all database instances up.


SOAHOST1> cd ORACLE_HOME/common/bin


	
Start the Configuration Wizard.


SOAHOST1> ./config.sh


	
In the Welcome screen, select Create a new WebLogic domain, and click Next.


	
In the Select Domain Source screen, do the following:

	
Select Generate a domain configured automatically to support the following products.


	
Select the following products:

	
Oracle Enterprise Scheduler Service Basic


	
Oracle WSM Policy Manager (this should be selected automatically)


	
Oracle JRF (this should be selected automatically)


	
Select the appropriate templates for the product that includes Oracle Enterprise Scheduler. Refer to that product's documentation on deploying it.If the embedding product installed Fusion Middleware Control and ESS-EM plugin, then select these templates also.







Click Next.

The remaining steps do not describe actions specific to deploying the product that includes Oracle Enterprise Scheduler. Refer to that product's documentation for details. The steps here describe actions specific to deploying Oracle Enterprise Scheduler.


	
In the Specify Domain Name and Location screen, enter the domain name you want.

Make sure that the domain directory matches the directory and shared storage mount point recommended in Oracle Fusion Middleware Enterprise Deployment Guide for Oracle SOA Suite.

Click Next.


	
In the Configure Administrator Username and Password screen, enter the username and password to be used for the domain's administrator.

Click Next.


	
In the Configure Server Start Mode and JDK screen, for Weblogic Domain Startup Mode, select Production Mode.

Click Next.


	
In the Configure JDBC Component Schema screen, do the following:

	
If the database is Oracle RAC, select Convert to GridLink or Convert to RAC multi data source as appropriate, then and click Next and configure accordingly. Otherwise, continue to the next step.


	
Select all the Component Schemas.

	
Select Driver: *Oracle's Driver (Thin) for Service connections


	
For the Oracle Enterprise Scheduler Schema and the Oracle Enterprise Scheduler MDS, enter the database SID instead of the database service name.


	
Fill in the host name where the database resides.


	
Fill in the database listener port.





	
Deselect the two MDS schemas, leaving only the ESS Schema selected. Type the Schema Owner and Schema Password for ESS.


	
Deselect "ESS Schema" and select "MDS Schema" and "OWSM MDS Schema". Type the Schema Owner and Schema Password for MDS.





	
In the Test JDBC Data Sources screen, the connections should be tested automatically. The Status column displays the results. Ensure that all connections were successful. If not, click Previous to return to the previous screen and correct your entries.

Click Next when all the connections are successful.


	
In the Select Advanced Configuration screen, do one of the following:

	
If ESS is to be configured on a single server, ess_server1, then click Next, and go to step 11.


	
Otherwise, select Manage Servers, Clusters and Machines and Deployments and Services.




Click Next.


	
In the Configure Managed Servers screen, optionally rename ess_server1 as desired. If you delete ess_server1 in this screen, Oracle Enterprise Scheduler will be deployed to the admin server automatically. You can also create more managed servers by clicking Add. Choose unique listen ports between 13000 and 13500 for each new server added.

Click Next.


	
In the Configure Clusters screen, if you want to create a cluster, click Add, then name your cluster. Leave the other entries as they are.

Click Next.


	
In the Assign Servers to Clusters screen, if you have created a cluster, add your servers to the cluster.

Click Next.


	
In the Configure Machines screen, add machines if needed.

Click Next.


	
In Target Deployments to Clusters or Servers screen, verify the targeting of components. No changes should be necessary.

	
The following applications should be targeted only to the ESS server or cluster: ESSAPP, wsm-pm.


	
The following libraries should be targeted only to the ESS server or cluster: oracle.ess.client*, oracle.ess*.


	
FMW Welcome Page Application will be targeted only to the admin server.


	
All other components should be targeted to both the admin server and ESS server or cluster.




Click Next.


	
On the Target Services to Clusters or Servers screen, verify the following targeting of services. No changes should be necessary.

	
JDBC System Resources EssDS, EssXADS, EssInternalDS, mds-ESS_MDS_DS should all be targeted to the ESS server or cluster.


	
All the other services should be targeted to both the admin server and the ESS server or cluster.




Click Next.


	
In the Configuration Summary screen, review and click Create.


	
In the Creating Domain screen, wait for the domain creation to complete, then click Done.

After these steps, the domain should be configured with both Oracle Enterprise Scheduler and the product that includes it.









3.3 Configuring Perl to Support Process Jobs

To complete domain setup, you need to configure Perl to support process jobs. Oracle Enterprise Scheduler internally uses Perl for supporting process jobs.

You do this in the Enterprise Manager.

	
In Enterprise Manager, from the Scheduling Service menu, choose Configuration > Application Properties.


	
Configure the ESS level property in ESSAPP called PerlCommand to the perl executable location. For example, PerlCommand = c:\Perl\bin\perl.exe.


	
Perl version is 5.8 or higher.


	
ESS locates perl in the following order:

	
From the configuration above.


	
If WL_HOME is defined, it looks here: $WL_HOME.../../webtier_mwhome/webtier/perl/bin/perl.


	
Otherwise, it uses it from the container's path.












3.4 Configuring Oracle Enterprise Scheduler

You can run Oracle Enterprise Scheduler as a single instance or as a cluster of servers. Each Oracle Enterprise Scheduler server includes a request processor and dispatcher, both of which must be configured.

Configuring Oracle Enterprise Scheduler involves the following main steps:

	
Configure a cluster. Optionally, configure a cluster of Oracle Enterprise Scheduler servers.


	
Configure the request processor. Configure the Oracle Enterprise Scheduler component which receives and manages job requests.


	
Configure the request dispatcher. Configure the Oracle Enterprise Scheduler component that polls the request processor for job requests and dispatches jobs.




This section contains the following topics:

	
Expanding an Oracle Enterprise Scheduler Cluster


	
Configuring a Request Processor


	
Configuring a Request Dispatcher






3.4.1 Expanding an Oracle Enterprise Scheduler Cluster

An Oracle Enterprise Scheduler cluster is created when the WebLogic domain is created. You may want to expand the cluster to handle a larger load. You can add new cluster nodes to an Oracle Enterprise Scheduler cluster from the Oracle WebLogic Server Console.

When scaling out an Oracle Enterprise Scheduler cluster with an additional managed server, it may be undesirable for the new server to immediately begin processing requests in the default work assignment. This could be the case if all other servers have work assignments bound in standard mode. If one or more of the running servers is using the default work assignment, however, then the present work allocation is compatible with a server using the default work assignment.

Oracle Enterprise Scheduler provides protection for a new server so that work allocations can be configured before the server begins processing jobs. When a newly added server starts for the first time, Oracle Enterprise Scheduler determines whether the default work assignment can be used. If it cannot, Oracle Enterprise Scheduler binds a pre-seeded internal work assignment (ESSInternalWA) which includes a health check job. You can use the health check job to check the server, and unbind the internal work assignment and then bind your own work assignment as required.




	
Note:

When determining whether the default work assignment can be used, Oracle Enterprise Scheduler considers all running servers in the group without regard to the applications that are deployed to the servers. Servers that are down are not taken into account.









For more information about work assignments, see Section 5.3.1.

For more information about expanding a cluster using Oracle WebLogic Server Console, see Oracle Fusion Middleware Oracle WebLogic Server Administration Console Online Help.






3.4.2 Configuring a Request Processor

A work assignment must be bound to a request processor before it can process job requests. A binding can be made in one of two modes: standard (the default) or exclusive.

Standard binding mode means the request processor can process job requests as defined by the specialization rules when an active workshift is defined. If a job request is specialized to two different work assignments, either of those work assignments or the default work assignment can process the job request.

When using exclusive binding mode, job requests specialized to the work assignment are processed exclusively by that work assignment when it is active. These job requests are excluded from all other work assignments, including the default work assignment. If the work assignment does not have an active workshift, then the job request can be processed by another work assignment.

Requirements for binding a work assignment are as follows:

	
The work assignment must be enabled, meaning its active flag must be set.


	
The work assignment must have at least one workshift.


	
Each workshift in the work assignment must have a thread allocation of at least one.


	
If the workshift includes a schedule, the following must be true:

	
The schedule must be active, meaning it is not expired.


	
The workshift duration must be at least one.





	
A work assignment can be bound to a particular server at most one time.


	
A work assignment can be bound to any number of servers in the group, but all bindings must use the same mode. Within a group, a work assignment cannot be bound in standard mode on one server and exclusive mode on another server.




For more information about work assignments, see Section 5.3.1.

To configure a request processor:

	
From the navigation pane, expand the Scheduling Services folder and select the Oracle Enterprise Scheduler application.


	
From the Scheduling Services menu, select Request Processor and then select Configure.


	
Under the Enable Request Processor field, enable or disable the request processor. Select the Enable Request Processor check box to turn on request processing.


	
Optionally, under the Work Assignment Bindings section, bind a work assignment to the request processor.

	
Add: To bind a work assignment to the request processor, click Add.

From the Select Work Assignment popup window, select a work assignment from the list and click OK.


	
Remove: To delete a work assignment binding from the job request processor, select a work assignment from the list of bindings and click Remove.


	
Exclusive Binding: Select to bind a work assignment exclusively to the request processor. The binding applies even if the work assignment is not enabled in the work assignment definition, or if the server is down. If a work assignment is bound to multiple servers, all the servers to which it is bound must use the same binding mode.





	
Optionally, under the Advanced Configuration section, configure the number of threads and the starvation threshold in minutes.

	
Thread Count: In the text field, enter the number of threads you want the processor to handle.


	
Starvation threshold (min): In the text field, enter the starvation threshold in minutes. The starvation threshold specifies the wait time for job requests.





	
Click Apply to save your changes.









3.4.3 Configuring a Request Dispatcher

Use the Configure Request Dispatcher page to enable or disable the job request dispatcher. You can also configure the polling interval for the request dispatcher.

Requests remain in waiting state in the Oracle Enterprise Scheduler repository, until the request dispatcher polls the repository for requests that are ready to run. After polling the repository, the dispatcher sets all requests to ready state. The request processor takes over control of the job requests once they have been placed in ready state.

The default maximum polling interval is 15 seconds.

To configure a request dispatcher:

	
From the navigation pane, expand the Scheduling Services folder and select the Oracle Enterprise Scheduler application.


	
From the Scheduling Services menu, select Request Dispatcher and then select Configure.


	
Under the Enable Request Dispatcher field, enable or disable the request processor.

Select the Enable Request Dispatcher check box to turn on request dispatching.


	
Optionally, under the Advanced Configuration section, configure the polling interval for the request dispatcher. In the Maximum Poll Interval field, enter the minimum interval at which the dispatcher polls for requests.


	
Click Apply to save your changes.











3.5 Searching for Configuration Changes to Oracle Enterprise Scheduler in Cloud Control

You can search for changes made to configurations using the search page in Cloud Control.

To search for changes to configurations to Oracle Enterprise Scheduler in Cloud Control:

	
Display the alerts for Oracle Enterprise Scheduler as described in Section 6.8.2.


	
In the Monitoring and Diagnostics pane, click the number of configuration changes to display the search page for configuration changes to Oracle Enterprise Scheduler alerts.

[image: Surrounding text describes schedule_ess_search_config.png.]

	
Configure your search as desired.

	
Target Type: Select the Scheduler Service or Scheduler Service Group.


	
Target Name: Search for or enter the name of the target you want to search. From the dropdown list, select the criterion by which you want to search for the target name: contains, is, is not, does not contain, starts with, ends with.


	
Type of Change: From the dropdown list, select the type of configuration change for which you want to search.


	
Show History Records: From the dropdown list, select the way you want the records to display, Grouped or Show All.


	
Include Member Target Changes: Select to display configuration changes made to members of the target.


	
Changes Discovered in Last: Select to search for changes discovered within a given number of days, weeks or months.


	
Changes Discovered: Select to search for changes discovered within a particular time period. Use the After and Before fields to enter the relevant time period.





	
Click Search to search for the changes.









3.6 Starting and Stopping Oracle Enterprise Scheduler Components

You can start up and shut down an instance of Oracle Enterprise Scheduler from Fusion Middleware Control.

The following components can be started and stopped:

	
Oracle Enterprise Scheduler instance.


	
Job request processor and dispatcher.







	
Note:

Stopping an Oracle Enterprise Scheduler instance or component is not recommended. Shutting down an Oracle Enterprise Scheduler component does not stop job requests from accumulating in the queue.









This section contains the following topics:

	
Starting and Stopping an Oracle Enterprise Scheduler Service Instance


	
Starting and Stopping a Request Processor or Dispatcher






3.6.1 Starting and Stopping an Oracle Enterprise Scheduler Service Instance

The Control menu for the scheduling service allows you to start an Oracle Enterprise Scheduler instance and consequently begin managing scheduled job requests.




	
Note:

Stopping an Oracle Enterprise Scheduler instance or component is not recommended.









To start up an instance of Oracle Enterprise Scheduler:

	
From the Scheduling Service menu, select Control.


	
Select Start Up.




To shut down an instance of Oracle Enterprise Scheduler:

	
From the Scheduling Service menu, select Control.


	
Select Shut Down.









3.6.2 Starting and Stopping a Request Processor or Dispatcher

You can start or stop a configured request processor or dispatcher from the Scheduling Service menu.




	
Note:

Stopping an Oracle Enterprise Scheduler instance or component is not recommended.









To stop a request processor or dispatcher:

	
From the navigation pane, expand the Scheduling Services folder and select the Oracle Enterprise Scheduler application.


	
Start the request processor or request dispatcher as follows.

	
To start the request processor: From the Scheduling Services menu, select Request Processor and then select Start.


	
To start the request dispatcher: From the Scheduling Services menu, select Request Dispatcher and then select Start.





	
Stop the request processor or request dispatcher as follows.

	
To stop the request processor: From the Scheduling Services menu, select Request Processor and then select Stop.


	
To stop the request dispatcher: From the Scheduling Services menu, select Request Dispatcher and then select Stop.





	
When prompted as to whether or not to stop the processor or dispatcher, click OK.











3.7 Managing Application Properties

You can configure Oracle Enterprise Scheduler interaction with applications by setting application properties. On the Application Properties page in Fusion Middleware Control, you can set values for properties that are defined by Oracle Enterprise Scheduler or properties specified for the application in its deployed configuration.

Oracle Enterprise Scheduler defines the following properties that you configure on the Application Properties page:

	
RequestFileDirectory: Specifies the directory for request and log output. The default is "{ESS_ENV:jrfServerLogPath}/ess_request/".


	
RequestFileDirectoryShared: Specifies a flag indicating whether the request file directory is shared. The default is "false".


	
PerlCommand: Specifies the binary path of Perl. The default is "/usr/bin/perl".


	
EssCallbackClientSecurityPolicyURI: Specifies the security policy URI used in the WS-Security headers for web service invocations from Oracle Enterprise Scheduler for web service callbacks. The default is null.


	
ClusterMode: Specifies whether the server instance is in standalone or extended mode. This is a read-only and immutable property.




To edit application properties:

	
From the navigation pane, expand the Scheduling Services folder and select the Oracle Enterprise Scheduler application.


	
From the Scheduling Services menu, select Configuration and then select Application Properties.

The Application Properties page displays.


	
In the Application dropdown field, select the application for which you want to set properties.


	
In the Configuration Properties section, locate the property whose value you want to change, then enter a new value in the Value column for that property.


	
To add a property, click the Add button.

The Add Property dialog box appears.


	
From the Type dropdown, select the new property's type.

	
Select ESS to choose a property defined by Oracle Enterprise Scheduler, then select the property's name from the Name dropdown. Enter the property's value in the Value text field.


	
Select another type to enter the name and value for another property.


	
Click OK to save the new property setting.





	
On the Application Properties page, click Apply to save application properties changes.









3.8 Managing Application and Role Policies

To control access to Oracle Enterprise Scheduler data and metadata, you can create application roles to represent users and user groups, then grant to them access to specific application resources.

This section describes how to create application roles. You might also be interested in the following sections:

	
For more on granting access to metadata, see Section 5.4 in Chapter 5, "Managing the Work of Oracle Enterprise Scheduler Jobs".


	
For more on granting access to data, see Section 4.4 in Chapter 4, "Managing Oracle Enterprise Scheduler Requests".






3.8.1 Managing Application Roles

Using Fusion Middleware Control, you can create application roles with which you later associate people and access privileges.

	
From the navigation pane, expand the WebLogic Domain folder and select the domain for which you're creating policies.


	
From the WebLogic Domain menu, select Security and then select Application Roles.

The Application Roles page displays.


	
In the Search section, from the Application Stripe dropdown, select the application stripe with which you want to work.


	
Click Create.

The Create Application Role page displays.


	
In the General section, in the Role Name field, enter the name for the application role you're creating.


	
Optionally, enter a display name and description in the fields provided.


	
In the Members section, click Add to search for members to add to the role.


	
In the Add Principal window, in the Search section, from the Type dropdown select a principal type. You can also add name information to narrow your search.

Note that the Type values are as follows:

	
An Application Role type is another application role.


	
A Group is a WebLogic Server user group.


	
A User is a WebLogic Server user.





	
Click the Search button to search for a principal based on the type and name you specified.


	
In the Searched Principals section, select the name of a principal you want to add to the role.


	
Click OK.


	
In Create Application Role page, click OK.











3.9 Managing Oracle Enterprise Scheduler Web Services

Oracle Enterprise Scheduler web services are the same as other application web services. For information about managing the web services, see the chapter "Understanding Oracle WSM Policy Framework" in the Oracle Fusion Middleware Security and Administrator's Guide for Oracle Web Services.







Managing Oracle Enterprise Scheduler Requests







4 Managing Oracle Enterprise Scheduler Requests


This chapter describes how to manage Oracle Enterprise Scheduler job requests, creating and submitting them, as well as holding and cancelling them as needed.

Job requests to do work on behalf of an application. A job request consists of the job execution type, such as Java job or PL/SQL job, a job definition that associates metadata for specifics about the request, and a schedule that guides when the job runs. Managing job requests can mean creating and submitting them, but also holding and cancelling them, as well as doing clean-up by purging requests from the database.

This chapter includes the following topics:

	
Introduction to Managing Oracle Enterprise Scheduler Job Requests


	
Managing Oracle Enterprise Scheduler Requests


	
Managing Purge Policies






4.1 Introduction to Managing Oracle Enterprise Scheduler Job Requests

Using Fusion Middleware Control Console, you can manage the job requests that do work on behalf of applications for which Oracle Enterprise Scheduler is providing services. Tasks related to managing job requests include creating job requests and specifying the schedules on which they run. You can submit the requests, as well as hold and cancel them.

Job request administration tasks you might need to perform include:

	
Creating job requests by associating request-specific metadata as job definitions, then defining schedules that guide when the job runs.


	
Holding, resuming, and cancelling requests.


	
Purging job requests from the database.









4.2 Managing Oracle Enterprise Scheduler Requests

An application uses Oracle Enterprise Scheduler to execute jobs on the application's behalf. When the application wants to execute a job, it sends a job request to Oracle Enterprise Scheduler. You configure those jobs by using job definitions that specify the job's parameters and associate them with the application. When you want to group together a collection of job requests, you create a job set.

The work of administering job requests includes submitting requests, searching for existing requests and viewing information about them, and pausing and cancelling requests. You can do these tasks with Fusion Middleware Control Console.

This section contains the following topics:

	
Submitting an Oracle Enterprise Scheduler Job Request


	
Searching for Oracle Enterprise Scheduler Job Requests


	
Viewing Job Request Details


	
Holding and Resuming Oracle Enterprise Scheduler Job Requests


	
Cancelling Oracle Enterprise Scheduler Job Requests






4.2.1 Submitting an Oracle Enterprise Scheduler Job Request

You can submit a job request by choosing a job definition that defines the metadata you want and by defining a schedule that guides when the job runs.

This section contains the following topics:

	
Creating a Job Request


	
Specifying a Job Request Schedule






4.2.1.1 Creating a Job Request

You create a job request by selecting a job definition for the job request, then selecting or creating a schedule.

You may want to configure system properties for the job request, such as the number of retries to attempt in the event of an execution error and a time out value for the job.

To submit a job request:

	
Use a pre-existing job definition. You can also first create a new job definition, as described in Section 5.2.1.2.


	
Navigate to the Submit Job Request page by clicking the Scheduling Service menu selecting Job Requests, then selecting Submit Job Request.


	
Select the application for which you want to submit the job request.

From the application dropdown list, select the application deployment name.


	
Under Job Request Details, enter a description of the job request in the Description text field.


	
Select a job definition.

	
Under Job Definition, click the search button next to the Job Definition text field.


	
Search for the required job definition.

In the Name text field, enter the name of the job definition you want to find. You can also enter the job definition's package in the Package field.

Click Go to search for the job definition.


	
From the search results table, select the job definition name.


	
Click OK.





	
In the Parameters region, optionally define any parameters you want to use with the scheduled job request.

	
In the Parameters region, click Add to add a parameter.

Fill in a name and value for the parameter.


	
You can set a value for any of the system properties available. Table 5-1 lists the names and descriptions of system properties.

For example, you may want to configure the number of permissible retries for the job (SYS_retries), or a time out value (SYS_request_timeout).





	
Select a schedule by which the job is to run.

	
Once: Select a single date and time by clicking the calendar icon.


	
Use existing schedule: Click the search button to search for and select an existing schedule. For more on defining saved schedules, see Section 4.2.3.


	
Specify schedule: Create your own schedule on the fly. Follow the instructions in Section 4.2.1.2





	
Click OK.









4.2.1.2 Specifying a Job Request Schedule

In the Submit Job Request page, selecting Specify schedule enables configuring your own schedule for a job request. You can configure a recurring job request using a job request schedule. Alternatively, you can configure a job request to run immediately or before a specified end date. Use a pre-existing job definition, or create a new job definition, as described in Section 5.2.1.2.

To specify a schedule:

	
In the Schedule region, select Specify schedule.


	
From the Frequency dropdown, select how often you want job requests using this schedule to run. Each frequency option will have its own way to specify details for the option. As you specify details, note that you can click Select date and time icons to specify time zones as well.


	
Select the Save Schedule check box to save this schedule for later use by this or other job requests, then enter the following:

	
Name: Enter a name for the schedule. This is the name that will appear when you're assigning the schedule to a job request.


	
Package: Optionally enter the name of a Java package related to this schedule if it will help you find or group schedules.


	
Description: Optionally enter a description.














4.2.2 Searching for Oracle Enterprise Scheduler Job Requests

The Request Search page enables searching for job requests. Using the Request Search page, you can:

	
Conduct a basic search that returns a list of job request details, including job request ID, executing application, job request status, and so on.


	
Conduct an advanced search that returns the same information as the simple search, as well as the date and time of execution, the run time or wait time of the job request, the number of retries and any error type that may have occurred during execution.


	
Modify the column display in the search results table.




This section contains the following topics:

	
Searching for a Job Request Using Simple Search


	
Searching for a Job Request Using the Advanced Search Feature


	
Configuring the Display of Columns in the Search Results Table






4.2.2.1 Searching for a Job Request Using Simple Search

Basic search allows you to find a job request according to particular criteria such as job request ID, related application, job request status, and so on, or by any one of a number of pre-configured quick searches.

To search for a job request:

	
Navigate to the Request Search page by clicking the Scheduling Service menu and selecting Job Requests, then selecting Search Job Requests.


	
Select the scope of the job request search by selecting one of the following options:

	
Current Scheduling Service: Select this option to search for job requests submitted only to the scheduling service with which you are currently working.


	
All Scheduling Services sharing the ESS repository: Select this option to search for job requests submitted to all scheduling services sharing the repository -- for example, all scheduling services in a cluster of scheduling services.

The repository -- the Oracle Enterprise Scheduler run-time database that holds jobs requests -- can be shared across multiple domains with Oracle Enterprise Scheduler. This might be useful to see jobs running across domains that might be stressing a shared resource, such as a database.





	
To run a fast search, from the Quick Search dropdown list, select a pre-configured search option as shown in the following list.

	
Requests submitted in the last hour


	
Pending requests submitted in the last 24 hours


	
Errored requests submitted in the last 24 hours


	
All running requests


	
All pending requests


	
Requests currently being retried


	
Requests retried in the last 24 hours


	
Requests that resulted in System Error in the last 24 hours


	
Requests that resulted in Business Error in the last 24 hours


	
Ready requests for selected Work Assignment.


	
Asynchronous requests that need manual recovery.




To run a regular job request search, skip this step.


	
Enter or select the criteria by which to search for job requests.

	
Request ID: Enter the ID of the job request for which you want to search.


	
Application: From the Application dropdown list, select the name of the application related to the job request for which you want to search. Alternatively, select All to search for job requests in all applications.


	
Status: Select the status of the job request for which you want to search. Alternatively, select All to search for job requests with all statuses. Statuses are listed in the following table.


	Statuses
	
BLOCKED

	
EXPIRED

	
SCHEDULE_ENDED


	
CANCELLED

	
FINISHED

	
SUCCEEDED


	
CANCELLING

	
HOLD

	
UNKNOWN


	
COMPLETED

	
PAUSED

	
VALIDATION_FAILED


	
ERROR

	
PENDING_VALIDATION

	
WAIT


	
ERROR AUTO RETRY

	
READY

	
WARNING


	
ERROR MANUAL RECOVERY

	
RUNNING

	







	
Execution Type: Options include Java Type, SQL Type, and Process Type.


	
Submitted: From the dropdown list, select the time period in which the job request to be searched has been submitted. Options include Last Hour, Last 24 Hours, Last 7 Days, Last 31 Days.


	
Submitted By: In the text field, enter the name of the user who submitted the job request you want to find.


	
Job Definition: Click the search button next to the text field and select the relevant job definition name.


	
Work Assignment: Click the search button next to the text field and select a work assignment from the list.


	
Product: In the text field, enter the name of the product using the job request.





	
Optionally, conduct an advanced search by clicking the Advanced button. For more on advanced search, see Section 4.2.2.2.


	
Click Search to submit the job request search.









4.2.2.2 Searching for a Job Request Using the Advanced Search Feature

An advanced search is available in the Request Search page by clicking the Advanced button.

To search for a job request:

	
Enter a basic search for a job request. Navigate to the Request Search page by clicking the Scheduling Service menu and selecting Job Requests, then selecting Search Job Requests.


	
Select the scope of the job request search by selecting one of the following options:

	
Current Scheduling Service: Select this option to search for job requests submitted only to the scheduling service with which you are currently working.


	
All Scheduling Services sharing the ESS repository: Select this option to search for job requests submitted to all scheduling services sharing the repository, for example all scheduling services in a cluster of scheduling services.

The repository -- the Oracle Enterprise Scheduler run-time database that holds jobs requests -- can be shared across multiple domains with Oracle Enterprise Scheduler. This might be useful to see jobs running across domains that might be stressing a shared resource, such as a database





	
Select your basic search criteria. For more information, see Section 4.2.2.1.


	
Click Advanced to display the fields for the advanced search.


	
In the Date Range section, configure the date range in which to search for job requests. The date on the left is the beginning date and the date on the right is the end date. For each date, click the calendar icon to the right of the text field to select the date and time.

	
Submitted between: Enter the start and end dates during which the job request was submitted.


	
Scheduled between: Enter the start and end dates during which the job request is scheduled to run.


	
Completed between: Enter the start and end dates during which the job request finished running.





	
In the Run Time/Wait Time section, select the run or wait time of the job request for which you are searching, such as long or short running requests.

	
None: Select if no run or wait time is to be specified.


	
Long running requests: Select to search for requests running longer than a specified number of seconds, minutes, hours or days.

In the Minimum Run Time text field, enter the lower limit of the time period for which the job request runs. From the dropdown list, select the required unit of time.


	
Short running requests that waited: Select to search for job requests running longer than a specified period of time and waiting less than a specified period.

In the Maximum Run Time text field, enter the upper limit of the time period for which the job request runs. From the dropdown list, select Seconds, Minutes, Hours or Days.

In the Minimum Wait Time text field, enter the lower limit of the time period during which the job request waits to run. From the dropdown list, select Seconds, Minutes, Hours or Days.


	
Waiting requests by time: Select to search for job requests waiting to run for a specified time period.

In the Minimum Wait Time text field, enter the lower limit of the time period during which the job request waits to run. From the dropdown list, select Seconds, Minutes, Hours or Days.

In the Maximum Wait Time text field, enter the upper limit of the time period during which the job request waits to run. From the dropdown list, select Seconds, Minutes, Hours or Days.





	
In the Retry of Failed Runs section, use the Number of Retries dropdown list to select an operator such as equal to, greater than, greater than or equal to, and so on.

In the text field, enter the number of retries.


	
In the Error Type section, use the dropdown list to select the type of error:

	
Business: A job ends in a business error when it must abort prematurely due to unforeseen conditions, but is otherwise able to exit with its data in a consistent state. A job request might end in a business error as a result of an application setup or configuration condition, a functional conflict that requires an early exit or corrupt or inconsistent data. You cannot retry running a job request that ends in a business error.


	
System: A job ends in a system error when a technical problem occurs from which the job cannot recover, but otherwise exits on its own. Alternatively, the computer running the job crashes. Examples include table space issues and unhandled run-time exceptions. You can retry running a job request that ends in a system error.





	
Click Search to submit the job request search.









4.2.2.3 Configuring the Display of Columns in the Search Results Table

After running a search for job requests, you can configure the display of columns in the search results table.

To configure job request search results table display columns:

	
Display the main Oracle Enterprise Scheduler Request search page and display the search interface.


	
Show or hide columns.

Click the View dropdown list and select Columns. then click column names to add check marks for the ones you want and remove check marks for those you don't.

You can also instead click Manage Columns to view the Manage Columns dialog box, through which you can show or hide columns. Use the arrows between the columns to move column names from the Visible to the Hidden column, or vice versa.


	
Optionally, reorder the columns by selecting the relevant column names and using the vertical arrows on the right to move them up or down.


	
Alternatively, display all columns by clicking the View dropdown list and select Columns, then Show All.











4.2.3 Creating or Editing Predefined Job Schedules

You can define and save schedules for later use in submitting job requests.

	
Navigate to the Schedules page by clicking the Scheduling Service menu, selecting Job Requests, then selecting Define Schedules.


	
To create a new schedule:

	
Click Create.


	
Enter the following information:

	
Name: Enter a name for the schedule. This is the name that will appear when you're assigning the schedule to a job request.


	
Package: Optionally enter the name of a Java package related to this schedule if it will help you find or group schedules.


	
Description: Optionally enter a description.





	
From the Frequency dropdown, select how often you want job requests using this schedule to run. Each frequency option will have its own way to specify details for the option As you specify details, note that you can click Select date and time icons to specify time zones as well.


	
Click OK.





	
To edit an existing schedule:

	
In the Name and Package fields, enter values to search for.


	
Click Go to search.


	
In the Results area, locate the schedule you want to edit.


	
Select the schedule you want to edit, then click Edit.


	
On the Edit Schedule page, edit details about the schedule.


	
Click OK.





	
Click Search to submit the job request search.









4.2.4 Viewing Job Request Details

You can view detailed information about an individual job request by clicking the job request ID or the request parent ID in job request search results. If the job is in an error state, an information box displays details regarding the error that occurred. For more on searching for job requests, see Section 4.2.2.

You can take the following actions on an individual job request:

	
Display log information for the job request.


	
Display the job set and all child job requests.


	
Submit a job or job set request with parameters similar to those of a given job request.


	
Recover an incomplete job request.




To view job request details:

	
Search for the relevant job requests as described in Section 4.2.2.1


	
In the table displaying the job request search results, select the job request whose details you want to view.


	
To view job request details, click the job request ID. Alternatively, click the parent ID associated with the job request to view the details of the job set with which the job is associated.

In the job request details page, you can take any of the following actions.

	
Request Log: Select Action and then select Request Log to display log information for the job request.


	
Request Tree: Select Action and then select Request Tree to display the parent job set along with all related child jobs.


	
Cancel: Select Action and then select Cancel to cancel the job request.


	
Hold: Select Action and then select Hold to temporarily suspend the job request.


	
Resume: Select Action and then select Resume to resume a suspended job request.


	
Recover Stuck Request: Select Action and then select Recover Stuck Request to recover an incomplete job request that cannot continue.


	
Change Priority: Select Action and then select Change Priority to raise or lower the priority of the job request. Job requests with a higher priority will be dispatched prior to job requests with lower priority.


	
Change Schedule: Select Action and then select Change Schedule to assign a different schedule to the job request.


	
Submit Like: Select Action and then select Submit Like to submit a job or job set with parameters similar to this one.












4.2.5 Holding and Resuming Oracle Enterprise Scheduler Job Requests

You can hold or resume a job request after it has been submitted.

To hold and resume a job request:

	
Search for a job request. For more information, see Section 4.2.2.1.


	
In the table of job request search results, select the job request you want to hold.


	
Click the Hold button.


	
To resume the paused job request, select the job request and click Resume.









4.2.6 Cancelling Oracle Enterprise Scheduler Job Requests

You can cancel an executable job request after it has been submitted. Executable job requests include job sets and job requests submitted without schedules. A job request can be canceled when it is not in a state of execution.

When initiating a job request cancellation, the resulting cancellation state depends on the current state of the job request. A job request that is not executing is set directly to CANCELLED state. A job request in RUNNING, PAUSED or COMPLETED states are placed in CANCELLING state following the initiation of request cancellation.

The final state of a request depends on the processing stage the job request at the point when cancellation has been initiated.

Table 4-1 displays the cancellation states applied to each executable request depending on its state when initiating cancellation.


Table 4-1 Executable Requests and Cancellation States

	Job State When Initiating Cancellation	New Cancellation State
	
WAIT

	
CANCELLED


	
READY

	
CANCELLED


	
HOLD

	
CANCELLED


	
BLOCKED

	
CANCELLED


	
PENDING_VALIDATION

	
CANCELLED


	
ERROR_AUTO_RETRY

	
CANCELLED


	
PAUSED

	
CANCELLING


	
RUNNING

	
CANCELLING


	
COMPLETED

	
CANCELLING


	
Any terminal state

	
No state change


	
CANCELLING

	
No state change


	
ERROR_MANUAL_RECOVERY

	
No state change








An executable request is processed in three major stages: pre-processor, executable and post-processor. Requests can be cancelled at any of these stages. If the job request cannot complete all three stages, it transitions to CANCELLED.

This section contains the following topics:

	
Initiating Cancellation During Pre-Process Handler Execution


	
Initiating Cancellation During Synchronous Java Job Execution


	
Initiating Cancellation During Asynchronous Java Job Execution


	
Initiating Cancellation During PL/SQL Job Execution


	
Initiating Cancellation During Spawned Job Execution


	
Cancelling Parent Job Requests


	
Cancelling a Child Job Request






4.2.6.1 Initiating Cancellation During Pre-Process Handler Execution

When initiating cancellation during the pre-processor stage, the state to which the job request transitions depends on the status returned by the pre-processor.

Table 4-2 displays the job state following cancellation initiation.


Table 4-2 Pre-processor States and States Following Cancellation Initiation

	State Returned by the Pre-Processor	State Following Cancellation Initiation
	
PROCEED

	
CANCELLED


	
DELAY

	
CANCELLED


	
WARN

	
CANCELLED


	
SYSTEM_ERROR

	
ERROR


	
BIZ_ERROR

	
ERROR












4.2.6.2 Initiating Cancellation During Synchronous Java Job Execution

When initiating cancellation during the job execution stage, the state to which the request transitions depends on the manner of completion.

Table 4-3 displays the job state following cancellation initiation.


Table 4-3 Returned Synchronous Java Job States and States Following Cancellation Initiation

	State Returned by the Job	State Following Cancellation Initiation
	
Normal return (success)

	
CANCELLED


	
ExecutionWarningException

	
CANCELLED


	
ExecutionPausedException

	
CANCELLED


	
ExecutionBizErrorException

	
ERROR


	
ExecutionErrorException

	
ERROR












4.2.6.3 Initiating Cancellation During Asynchronous Java Job Execution

When initiating cancellation during the job execution stage, the state to which the request transitions depends on the manner of completion.

Table 4-4 displays the job state following cancellation initiation.


Table 4-4 Returned Asynchronous Java Job States and States Following Cancellation Initiation

	State Returned by the Job	State Following Cancellation Initiation
	
SUCCESS

	
CANCELLED


	
PAUSE

	
CANCELLED


	
WARNING

	
CANCELLED


	
ERROR

	
ERROR


	
CANCEL

	
CANCELLED


	
UPDATE

	
No state change. Wait for further updates.


	
BIZ_ERROR

	
ERROR


	
ERROR_MANUAL_RECOVERY

	
ERROR_MANUAL_RECOVERY












4.2.6.4 Initiating Cancellation During PL/SQL Job Execution

If the job executable is executing, Oracle Enterprise Scheduler attempts to kill the running RDBMS Scheduler job. If the job is successfully killed, the request transitions to CANCELLED state. If the RDBMS Scheduler job completes before it can be killed, the state to which the job request transitions depends on the result of the job execution.

Table 4-5 displays the job state following cancellation initiation.


Table 4-5 Returned PL/SQL Job States and States Following Cancellation Initiation

	State Returned by the Job	State Following Cancellation Initiation
	
SUCCESS

	
CANCELLED


	
WARNING

	
CANCELLED


	
PAUSE

	
CANCELLED


	
BIZ_ERROR

	
ERROR


	
SYSTEM_ERROR

	
ERROR












4.2.6.5 Initiating Cancellation During Spawned Job Execution

If the spawned job is executing, Oracle Enterprise Scheduler attempts to kill the running process. If the process is successfully killed, the request transitions to a CANCELLED state. If the process completes before it can be killed, the state to which the request transitions depends on the result of the process execution.

Table 4-6 displays the job state following cancellation initiation.


Table 4-6 Returned Spawned Job States and States Following Cancellation Initiation

	State Returned by the Job	State Following Cancellation
	
SUCCESS

	
CANCELLED


	
WARNING

	
CANCELLED


	
PAUSE

	
CANCELLED


	
BIZ_ERROR

	
CANCELLED


	
SYSTEM_ERROR

	
CANCELLED












4.2.6.6 Cancelling Parent Job Requests

A parent job request that is not executable must be in WAIT state to be canceled. It then proceeds to CANCELLING. The cancellation operation propagates to all eligible child job requests. For example, job set steps are canceled when the job set is canceled, sub-requests are canceled when the parent request is canceled and recurring executable job requests are canceled when the recurring parent is canceled. If a child job request is executable, it is subject to the rules described in the preceding sections. When all the child requests have completed, the parent request transitions to CANCELLED state.






4.2.6.7 Cancelling a Child Job Request

A child job request may be an executable or a parent job request. When cancelling a sub-request that completes in CANCELLED or another terminal state, the parent job request resumes as usual as long as the parent job request has not been canceled as well. The state of the sub-request does not affect the state of the parent request.

When cancelling a step within a job set, the job set transitions to a CANCELLED state when the job set step transitions to a CANCELLED state. However, the job set may not revert to CANCELLED state if another job set step results in an error.

To cancel a job request:

	
Search for a job request.


	
In the table of job request search results, select the job request you want to cancel.


	
Click the Cancel button.













4.3 Managing Purge Policies

Purge policies allow the scheduling service to remove scheduled jobs according to specified criteria. For example, a purge policy might specify the retention of all Java type job requests using a particular job definition submitted executed by a given application for three days. Another purge policy might retain a particular type of job request, say, all SQL job requests in a successful state, for only one day. You can also specify the frequency at which the purge policy is to run.

This section contains the following topics:

	
Setting Up a New Purge Policy


	
Physically Purging Job Requests from the Database


	
Viewing Purge Policies


	
Updating a Purge Policy


	
Deleting a Purge Policy






4.3.1 Setting Up a New Purge Policy

A purge policy determines which job requests are to be purged and which retained. Defining a purge policy involves:

	
Selecting the jobs to be purged: Selection criteria include the related application or product, a particular job definition or job type, the job submitter or a maximum number of requests.


	
Specifying retention criteria: Decide how long job requests are to be retained depending on their status.


	
Specifying purge frequency: Decide how often you want the purge policy to run.







	
Note:

After a purge policy has run, it is necessary to physically delete purged job requests from the database. For more information, see Section 4.3.2.









To set up a new purge policy:

	
From the navigation pane, expand the Scheduling Services folder and select the Oracle Enterprise Scheduler application.


	
From the Scheduling Services menu, select Purge Policies.


	
To configure a new policy, click Setup New.

In the Setup Purge Policy page, configure the purge policy.


	
In the Description text field, enter a description for the purge policy.


	
In the Request Criteria for Purge section, configure the characteristics of the job requests to be purged.

	
Application: From the dropdown list, select the application for which you want to create a purge policy.


	
Product: Enter the name of the product.


	
Job Definition: Click the browse button next to the Job Definition text field.

In the Select Job Definition window, enter the name of the job definition in the Name text field.

Click Go to search, then select the relevant job definition from those that display. Click OK.


	
Execution Type: From the dropdown list, select the job type required: All, Java Type, SQL Type, or Process Type.


	
Submitted by: Enter the name of the job submitter.





	
In the Retention Criteria for Purge section, configure the characteristics of the job requests to be retained.

	
Default Retention Period (in days): Enter the default period, in days, during which requests are to be retained.


	
Retention Period - Success (in days): Enter the period, in days, during which successful job requests are retained.


	
Retention Period - Error (in days): Enter the period, in days, during which errored job requests are retained.


	
Retention Period - Warning (in days): Enter the period, in days, during which job requests ending in a warning status are retained.


	
Retention Period - Cancelled (in days): Enter the period, in days, during which canceled job requests are retained.





	
In the Schedule section, set a schedule for the job request purge policy.

	
To run the purge policy only one time, select Once. Click the calendar icon to select the date and time you want the purge policy to run.


	
To set a schedule for the purge policy, select Use Existing Schedule. Click the browse button to search for a schedule.

In the Select Schedule window, select a schedule and click OK.





	
In the Advanced section, in the Maximum requests to be processed text field, enter the maximum number of job requests to be processed.


	
Click OK to save the purge policy.









4.3.2 Physically Purging Job Requests from the Database

Job request data is kept in the Oracle Enterprise Scheduler run-time store as records in the run-time store tables. These job requests records are kept in the run-time store until they are physically purged by a database administrator using SQL purge scripts. You must logically delete a job request before physically purging it.

Use the method esspurge.purge_requests on the Oracle Enterprise Scheduler schema to delete purged job requests from the database. In an Oracle Fusion Applications environment, the schema is typically called FUSION_ORA_ESS.

The ESSPURGE package contains a stored procedure which you can use to purge completed job requests. The package is normally loaded when the Oracle Enterprise Scheduler schema is created or updated. The stored procedure is shown in Example 4-1.


Example 4-1 ESSPURGE Stored Procedure for Purging Completed Job Requests


--- Purges job requests that have completed.
---
--- p_older_than : Purge only job requests that have completed after this time.
--- p_max_count : The maximum number of job requests to purge.
--- p_max_runtime : The maximum time, in minutes, the purge should run.
---    If null (default), this defaults to one day which effectively means
---    there is no time limit.
---
procedure purge_requests
( p_older_than in timestamp,
  p_max_count in number,
  p_max_runtime integer default null );




The basic syntax of esspurge.purge_requests is shown in Example 4-2, where FUSION_ORA_ESS is the name of the Oracle Enterprise Scheduler schema and password is the password.


Example 4-2 Purging Job Requests from the Database


sqlplus FUSION_ORA_ESS/password
set serveroutput on size unlimited
set timing on
execute esspurge.purge_requests(systimestamp, 1000000);




Additional examples are shown in the following list.

	
To purge job requests completed earlier than the current time, at a maximum of 50000 job requests, execute the following command:


execute esspurge.purge_requests(systimestamp, 50000);


	
To purge job requests completed 30 days earlier, at a maximum of 50000 job requests, execute the following command:


execute esspurge.purge_requests(systimestamp - 30, 50000);


	
To purge job requests that completed before June 01, 2010 at 15:00:00 (UTC), at a maximum of 50000 job requests, execute the following command:


execute esspurge.purge_requests(TIMESTAMP '2010-06-01 15:00:00 -00:00', 50000);









4.3.3 Viewing Purge Policies

You can view all purge policies defined for the scheduling service.

To display purge policies for the scheduling service:

	
From the navigation pane, expand the Scheduling Services folder and select the Oracle Enterprise Scheduler application.


	
From the Scheduling Services menu, select Purge Policies.









4.3.4 Updating a Purge Policy

You can edit the request or retention criteria of an existing purge policy, as well as the purge policy schedule.

To update a purge policy:

	
From the navigation pane, expand the Scheduling Services folder and select the Oracle Enterprise Scheduler application.


	
From the Scheduling Services menu, select Purge Policies.


	
From the Purge Policies table, select the policy you want to update and click Update.


	
Edit the purge policy accordingly and click OK.









4.3.5 Deleting a Purge Policy

You can delete a given purge policy.

To delete a purge policy:

	
From the navigation pane, expand the Scheduling Services folder and select the Oracle Enterprise Scheduler application.


	
From the Scheduling Services menu, select Purge Policies.


	
From the Purge Policies table, select the policy you want to delete and click Delete.











4.4 Configuring Simple Data Security for Job Requests

Oracle Simple Data Security enforces security authorizations for access and modification of specific data records. Oracle Simple Data Security integrates with Oracle Platform Security Services (OPSS) by granting actions to OPSS principals. The grant defines who (the principals) can do what (the actions) on a given resource. A grant in Oracle Simple Data Security can use any enterprise user or enterprise group as principals.

In the context of Oracle Enterprise Scheduler, a job request access control data security policy comprises a grant, a grantee and a set of oracle.as.scheduler.security.RuntimeDataPermission privileges for a set of job requests as follows:

	
A grantee, represented by grantee ID such as a user or application role. The ID should match the user GUID or application role GUID retrieved from Oracle Fusion Middleware.




You can manage the job request access control data security policy using Oracle Enterprise Manager.

The following behaviors are in place by default:

	
A user by default can see only the requests they submitted.


	
If a user can see a request, then they can see the request logs.


	
If a user can see a request, and if the request does not run as elevated privilege, then the user may see the request output.


	
If a user can see a request, and if the request run as elevated user, the user is not able to request output.


	
A request run-as user (elevated user, if specified) is able to see the request, request log, and request output.


	
An Administrators group user (for example, "weblogic") is able to see all the requests and request logs.


	
Administrators user is not able to see request output unless the requests were submitted and run as himself.






4.4.1 Oracle Simple Data Security Actions

You can use Enterprise Manager to create functional and data security policies for Oracle Enterprise Scheduler. There, you can associate actions with roles to create a policy.

Table 4-7 lists available Simple Data Security actions.


Table 4-7 Grant Actions for Data Security

	Action	Effect
	
ESS_REQUEST_READ

	
Read the request, get request state, and get details.


	
ESS_REQUEST_UPDATE

	
Update the request.


	
ESS_REQUEST_HOLD

	
Hold request execution.


	
ESS_REQUEST_CANCEL

	
Cancel a request execution.


	
ESS_REQUEST_LOCK

	
Lock a request.


	
ESS_REQUEST_RELEASE

	
Release the lock on a request.


	
ESS_REQUEST_DELETE

	
Delete a request.


	
ESS_REQUEST_PURGE

	
Purge a request.


	
ESS_REQUEST_OUTPUT_READ

	
View the output of a request.


	
ESS_REQUEST_OUTPUT_DELETE

	
Delete the output of a request.


	
ESS_REQUEST_OUTPUT_UPDATE

	
Update the output of a request.












4.4.2 How to Create Data Security Policies for Oracle Enterprise Scheduler Components

You can use Enterprise Manager to create functional and data security policies for Oracle Enterprise Scheduler.

	
From the navigation pane, expand the WebLogic Domain folder and select the domain for which you're creating policies.


	
From the WebLogic Domain menu, select Security and then select Application Policies.

The Application Policies page displays.


	
In the Search section, from the Application Stripe dropdown, select the application stripe with which you want to work.


	
Click Create to begin granting permissions to certain users, groups, or application roles.

The Create Application Grant page appears.


	
In the Create Application Grant page, in the Grantee section, click Add.


	
In the Add Principal window, from the Type dropdown, select a type of principal, then enter a principal name or display name and click the search button to find the principal you want to add.


	
Under Search Principals, click the principal you want, then click OK.


	
In the Permissions section, click Add.


	
In the Search section, click Permissions.


	
From the Permission Class dropdown, select oracle.as.scheduler.security.RuntimeDataPermission.


	
Click the Search button.


	
Under Search Results, select Scope=APPLICATION, then click Continue.


	
In the Add Permission dialog, in the Permission Actions field, edit the comma-separated list of permissions so that the list reflects the permissions you want to grant.


	
Click OK.
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6 Monitoring Oracle Enterprise Scheduler


This chapter describes how you can monitor performance of Oracle Enterprise Scheduler job requests and server instances. You can also get component status and log information.

This chapter includes the following topics:

	
Overview of Monitoring Oracle Enterprise Scheduler


	
Monitoring Oracle Enterprise Scheduler Request Activity


	
Monitoring the Performance of a Single Oracle Enterprise Scheduler Instance


	
Monitoring Key Performance Metrics for Oracle Enterprise Scheduler


	
Viewing General Oracle Enterprise Scheduler Instance Information


	
Viewing Scheduler Component Status


	
Managing Logging for Oracle Enterprise Scheduler


	
Managing Alerts for Oracle Enterprise Scheduler in Cloud Control






6.1 Overview of Monitoring Oracle Enterprise Scheduler

Much of the monitoring you'll do is related to job requests, where Oracle Enterprise Scheduler work is done. You can get a snapshot of recent work done as job requests, including the load those requests are placing on the system. You can also view the status of current and pending requests.

For an Oracle Enterprise Scheduler instance, you can find out how it is performing currently and how it has performed historically.

You can get the status of a service instance, as well as service components such as the request dispatcher and processor.

Finally, you can get log information about job requests and Oracle Enterprise Scheduler.

Use Fusion Middleware Control to do most of the monitoring you'll need. It's user interface provides data about system performance in both graphical and tabular form.






6.2 Monitoring Oracle Enterprise Scheduler Request Activity

You can monitor job requests using Oracle Enterprise Manager Fusion Middleware Control Console. On the console's Scheduling Service Home page, you can get the following information:

	
A list of the 10 job requests that have been running for the longest period of time.


	
A list of the top 10 job requests that are waiting to be run.


	
A chart showing completion status percentages for job requests over the last hour.


	
A chart showing the number of requests completed in the last hour, along with the average processing time over that period.


	
A list of performance data, such as average and maximum processing and wait times.






6.2.1 Viewing Top Ten Long Running Requests and Top Ten Ready Requests

In the Oracle Enterprise Manager Fusion Middleware Control Console, the Oracle Enterprise Scheduler home page displays two important categories of information: data about the top ten long running scheduled jobs and data about the top ten job requests awaiting execution. These are displayed on separate tabs.

By default, only the job requests within the current scheduling service display. However, you can change the scope such that all relevant scheduled jobs running on all scheduling services sharing the Oracle Enterprise Scheduler repository display in the tabs.

Each of the tabs includes a table that displays a short list of job requests. The Show All Ready or Show All Running link at the bottom of the region displays a search page in which it is possible to search for a more comprehensive list of relevant job requests.

Each tab displays the following information about scheduled job requests:

	
Request ID: The ID associated with the job request.


	
Run Time/Wait Time: The period of time during which the job request has been running or awaiting execution, respectively.


	
Job Definition: The job definition associated with the job request.


	
Submitted by: The name of the user who submitted the job request.


	
Application: The name of the application with which the job request is associated.


	
Execution Type: The category of job being executed—Java, SQL or process job.


	
Description: An optional description of the scheduled job request.




This section contains the following topics:

	
Viewing Top Ten Long Running Oracle Enterprise Scheduler Requests


	
Viewing Top Ten Oracle Enterprise Scheduler Jobs Ready to Be Executed






6.2.1.1 Viewing Top Ten Long Running Oracle Enterprise Scheduler Requests

The Top Ten Long Running Requests tab displays the top ten long running scheduled job requests, including request ID, job run time, job definition used, executing application, job execution type and description. You can set the scope of the top ten long running requests displayed to the current scheduling service only, or all scheduling services sharing the Oracle Enterprise Scheduler repository.

Use the Top Ten Long Running Job Requests tab to view the job requests that have been running for the longest period of time on the Oracle Enterprise Scheduler service. You can alternatively change the scope of the region to display the top ten long running job requests on all scheduling services sharing the same repository.

The job requests displayed will all have a status of RUNNING.

To view the top ten long running requests:

	
From the navigation pane, expand the Scheduling Services folder and select the Oracle Enterprise Scheduler application.


	
At the top of the Oracle Enterprise Scheduler home page, click the Top 10 Long Running Requests tab to display the ten job requests that have been running the longest.


	
To display all running job requests, click Show All Running at the bottom of the chart. This displays a search form that searches for all requests that are currently running. Click Search to display the requests.









6.2.1.2 Viewing Top Ten Oracle Enterprise Scheduler Jobs Ready to Be Executed

The Top Ten Ready Job Requests tab displays the top ten scheduled job requests that await execution. The tab displays the same information as the Top Ten Long Running Requests tab, except the wait time displays for each job rather than the run time.

Use the Top Ten Ready Job Requests tab to view the job requests that are awaiting execution on the Oracle Enterprise Scheduler. You can also change the scope of the region to display the top ten ready job requests on all scheduling services sharing the same repository.

The job requests displayed will all have a status of READY.

To view the top ten ready job requests:

	
From the navigation pane, expand the Scheduling Services folder and select the Oracle Enterprise Scheduler application.


	
At the top of the Oracle Enterprise Scheduler page, click the Top 10 Ready Requests tab to display the ten job requests with the status READY.


	
To display all ready job requests, click Show All Ready at the bottom of the chart. This displays a search form that searches for all requests with the status READY. Click Search to display the requests.











6.2.2 Viewing Completed Job Requests

You can view the status of completed job requests on the Scheduling Service home page of the Fusion Middleware Control. There, in the Completed Job Requests region, each completion status is shown as a percentage of the total of job requests completed in the last hour. Status shown includes Success, Warning, Error, and Cancelled.






6.2.3 Viewing Job Request Response and Load

You can view the information about the processing load that has been required to complete job requests on the Scheduling Service home page of the Fusion Middleware Control. In the Response and Load region, you can view performance monitoring statistics regarding the time required to process to job requests.

Table 6-1 describes the performance monitoring statistics in the Response and Load region.


Table 6-1 Response and Load Statistics

	Statistic	Description
	
Average Processing time for Last Hour

	
This metric specifies the average time required to process jobs during the last hour.


	
Requests Completed Per Hour

	
This metric specifies the number of scheduled job requests completed within the last hour.












6.2.4 Viewing Performance as Processing and Wait Times

You can view job request processing and wait times on the Scheduling Service home page of the Fusion Middleware Control.

Table 6-2 describes the performance monitoring statistics in the Performance region.


Table 6-2 Performance Statistics

	Statistic	Description
	
Maximum Processing Time

	
The maximum amount of time required to process a scheduled job.


	
Average Processing Time

	
The average amount of time required to process a scheduled job.


	
Maximum Wait Time

	
The maximum amount of time during which a scheduled job waits before running.


	
Average Wait Time

	
The average amount of time during which a scheduled job waits before running.














6.3 Monitoring the Performance of a Single Oracle Enterprise Scheduler Instance

You can monitor the performance of an Oracle Enterprise Scheduler instance, specifically current and historical performance data, as well as a summary of all performance data. Performance data displays in a chart set that you can save, delete, and reorder. You can also modify the time period for which performance data displays.

This section contains the following topics:

	
Viewing a Summary of Oracle Enterprise Scheduler Activity


	
Viewing Current Oracle Enterprise Scheduler Activity


	
Viewing Historical Oracle Enterprise Scheduler Reports


	
Managing Chart Sets


	
Selecting the Performance Time Period






6.3.1 Viewing a Summary of Oracle Enterprise Scheduler Activity

The Oracle Enterprise Scheduler Performance Summary page displays current charts of job requests such as requests completed per hour, running requests, requests by processing time and requests by status.

To view a summary of Oracle Enterprise Scheduler activity:

	
From the Scheduling Service menu, choose Performance > Service Summary.

By default, this page displays job requests running during a selected time period in the following categories:

	
Requests completed per hour


	
Processing times, average, minimum and maximum


	
Running requests and maximum running requests


	
Requests over the past hour with the status SUCCESS, WARNING, ERROR or CANCEL.




You can change the metrics displayed on the Service Summary performance page. Click the Show Metric Palette button to display the metric palette for Oracle Enterprise Scheduler.


	
You can change the duration for which performance data display.


	
Optionally, you can change the display format of performance data on the page.

Choose View > Grid to remove the grid display format from the charts.

Click the Table View link to display the performance data in table format.


	
You can overlay an additional scheduler service over the current service performance metrics.

	
Choose Overlay > Another Scheduler Service.

In the Search and Select: Targets window, enter the name of the target and host server and click Go to search for the relevant service.


	
From the search results table, select the relevant service and click Select to choose the scheduler service to overlay.





	
Additionally, you can take any of the following actions.

	
Save the chart set, as described in Section 6.3.4.1, "Saving a Chart Set".


	
Reorder the chart set, as described in Section 6.3.4.3, "Reordering Charts".


	
Revert to an old chart set, as described in Section 6.3.4.4, "Reverting to an Old Chart Set".


	
Delete a chart set, as described in Section 6.3.4.2, "Deleting a Chart Set".












6.3.2 Viewing Current Oracle Enterprise Scheduler Activity

The Oracle Enterprise Scheduler Current Activity page displays pending and running requests by user and application.

To view current Oracle Enterprise Scheduler activity:

	
From the Scheduling Service menu, choose Performance > Current Activity.


	
You can view pending and running requests by user or application, or workload by work assignment.

To view pending and running requests by user, choose View > Requests By User.

To view pending and running requests by application, choose View > Requests By Application.

To view workloads by work assignment, choose View > Workload By Work Assignment. For more information about work assignment details, see Section 5.3.1.1, "Creating or Editing a Work Assignment."









6.3.3 Viewing Historical Oracle Enterprise Scheduler Reports

The Oracle Enterprise Scheduler Historical Reports page displays completed job requests by user, application and work assignment.

To view historical Oracle Enterprise Scheduler reports:

	
From the Scheduling Service menu, choose Performance > Historical Reports.


	
From the View list, choose one of the following report views:

	
Completed Request Statistics By Job Name


	
Completed Request Statistics By User


	
Request Metrics By Work Assignment


	
Completed Request Statistics





	
Adjust the filter criteria as required. The filter criteria vary depending on the report view you choose.


Table 6-3 Completed Request Statistics by Job Name

	Filter Criterion	What to Do...
	
Application

	
From the list, choose the application whose statistics you want to view.


	
Minimum Run Time

	
Enter the shortest run time period for jobs whose statistics you want to view. Use the text field to enter a number, and select a unit of time from the list: Seconds, Minutes, Hours or Days.


	
Completed between

	
Use the calendar icons on either side of the text fields to select a start and end date and time.









Table 6-4 Completed Request Statistics by User

	Filter Criterion	What to Do...
	
Application

	
From the list, choose the application whose statistics you want to view.


	
Minimum Total Run Time

	
Enter the shortest total time period for jobs whose statistics you want to view. Use the text field to enter a number, and select a unit of time from the list: Seconds, Minutes, Hours or Days.


	
Completed between

	
Use the calendar icons on either side of the text fields to select a start and end date and time.









Table 6-5 Request Metrics By Work Assignment

	Filter Criterion	What to Do...
	
Application

	
From the list, choose the application whose statistics you want to view.


	
Completed after

	
Use the calendar icon to choose the date and time after which the work assignment has completed.









Table 6-6 Completed Request Statistics

	Filter Criterion	What to Do...
	
Application

	
From the list, choose the application whose statistics you want to view.


	
Completed between

	
Use the calendar icons on either side of the text fields to choose a start and end date and time.








	
Click Go to search for and display the historical data.









6.3.4 Managing Chart Sets

You can save or delete the chart set displayed in the Oracle Enterprise Scheduler Performance Summary page. You can also re-organize the order of a chart and revert to an old chart set.

This section contains the following topics:

	
Saving a Chart Set


	
Deleting a Chart Set


	
Reordering Charts


	
Reverting to an Old Chart Set






6.3.4.1 Saving a Chart Set

You can save the chart set displayed in the Oracle Enterprise Scheduler Performance Summary page. Saving a chart set allows preserving a specific set of metrics selected for display, as opposed to the default metrics.

To save a chart set:

	
Display the Oracle Enterprise Scheduler Performance Summary page.


	
Choose View > Save Chart Set.


	
In the Save Chart Set dialog box, enter a name for the chart set and click OK.


	
Once you have saved the chart set, you can display it by choosing Chart Set > My Chart Set.









6.3.4.2 Deleting a Chart Set

You can delete saved chart set files created in the Oracle Enterprise Scheduler Performance Summary page.

To delete a chart set:

	
Display the Oracle Enterprise Scheduler Performance Summary page.


	
Choose View > Delete Chart Sets.


	
In the Delete Chart Sets dialog box, select the name of the chart set to be deleted and click OK.









6.3.4.3 Reordering Charts

You can organize the display of performance charts in the Oracle Enterprise Scheduler Performance Summary page. Charts can be moved up or down, or removed entirely.

To reorder chart sets:

	
Display the Oracle Enterprise Scheduler Performance Summary page.


	
Choose View > Reorder Charts.


	
In the Reorder Charts popup window, select the chart you want to move and click Move Up or Move Down, respectively.

To delete a chart from the Performance Summary page, select the chart and click Delete.


	
Click OK.









6.3.4.4 Reverting to an Old Chart Set

If you have re-organized your chart sets, you can revert to the chart set as you had originally saved it.

To revert chart sets:

	
Display the Oracle Enterprise Scheduler Performance Summary page.


	
From the Chart Set list, choose the chart you want to revert to its original display.


	
Choose View > Revert Chart Set.











6.3.5 Selecting the Performance Time Period

In the Oracle Enterprise Scheduler Performance Summary page, you can change the time period for which the performance summary displays.

To select the performance time period:

	
Display the Oracle Enterprise Scheduler Performance Summary page.


	
Change the duration for which job requests display.

	
All: Click to display all job requests within a specified, finite period.


	
15 minutes: Click to display all job requests within the past fifteen minutes.


	
Slider: Click to display a slider that enables scrolling horizontally to show job requests from a specified period. The slider defaults to whichever time segment is selected, "all," 2 hours, or 15 minutes.


	
Calendar: Click the calendar icon to select a time period for which you want to display job requests.














6.4 Monitoring Key Performance Metrics for Oracle Enterprise Scheduler

Use Table 6-7 to locate the key performance metrics for Oracle Enterprise Scheduler.


Table 6-7 Oracle Enterprise Scheduler Key Performance Metrics

	Metric Name	Location in Fusion Middleware Control
	
Number of active processor threads for each instance

	
	
From the navigation pane, expand Scheduling Services.


	
Select the Oracle Enterprise Scheduler component.


	
From the Scheduling Service menu, choose Performance > Current Activity.


	
From the View list, choose Workload by Work Assignment.


	
In the Work Assignments with active Workshifts report, view the Thread Allocation columns.





	
Processing Time (for jobs)

Wait Time

	
	
From the navigation pane, expand Scheduling Services.


	
Select the Oracle Enterprise Scheduler component.


	
From the Scheduling Service menu, choose Performance > Historical Reports.


	
In the Historical Reports page, from the View list, choose Request Metrics By Work Assignment.


	
In the Results section, view the Wait Time and Processing Time columns.





	
Job running time

	
	
From the navigation pane, expand Scheduling Services.


	
Select the Oracle Enterprise Scheduler component.


	
From the Scheduling Service home page, in the Top 10 Long Running Request tab, select a job.


	
In the Request Detail page, under Execution Trail, view the Run Time metric.















6.5 Viewing General Oracle Enterprise Scheduler Instance Information

You can view information about a particular Oracle Enterprise Scheduler instance by using the Scheduling Service General Information popup window in Fusion Middleware Control. The popup window displays the locations of Oracle Fusion Middleware home, the domain and the target application, as well as the version of Oracle Fusion Middleware currently running and the URI of the hosting server.

To view general information about Oracle Enterprise Scheduler:

	
From the Scheduling Service menu, select one of the following:

	
From the Scheduling Service menu, select General Information.


	
In Cloud Control, from the Scheduling Service menu, select Target Information.





	
Fusion Middleware Control displays the following information.

	
Target Name: The location of the target application, in this case, Oracle Enterprise Scheduler, running on the domain.


	
Version: The version number of Oracle Fusion Middleware.


	
Middleware Home: The location of the Oracle Fusion Middleware directory.


	
Domain Home: The full path of the domain.


	
Host: The URI of the hosting server.












6.6 Viewing Scheduler Component Status

You can view status for components of Oracle Enterprise Scheduler. On the Scheduling Service home page of Fusion Middleware Control, the Scheduler Components region displays status for the job request processor and dispatcher. The region displays the status (such as whether it's started or stopped) of each component, the name of the server to which it is deployed, and whether or not the component is enabled. You can start and stop each component there.






6.7 Managing Logging for Oracle Enterprise Scheduler

You can search for and view log data for individual job requests, as well as set log levels for Oracle Enterprise Scheduler. You can also save job request logs to a file, and trace job requests for additional troubleshooting information.

This section contains the following topics:

	
Viewing Log Information for the Domain


	
Viewing Job Request Logs


	
Viewing Log Messages for Scheduled Job Requests


	
Setting Oracle Enterprise Scheduler Log Levels


	
Tracing Oracle Enterprise Scheduler Jobs


	
Saving Job Request Logs







	
Note:

The Oracle WebLogic Server logger (logging.xml) only shows logs written by Oracle Enterprise Scheduler job running in Oracle WebLogic Server. Once Oracle Enterprise Scheduler transfers control of running PL/SQL to the PL/SQL process, PL/SQL job logging data is not written to the Oracle Enterprise Scheduler logs as they run in a separate process.











6.7.1 Viewing Log Information for the Domain

You can use the Fusion Middleware Control to view log messages for the domain on which Oracle Enterprise Scheduler is deployed.

To view domain logs:

	
From the Scheduling Service menu, select Logs > View Log Messages.




For more information, see the Oracle Fusion Middleware Administrator's Guide.






6.7.2 Viewing Job Request Logs

You can view the log for a particular job request from the Request Details pane.




	
Note:

On Windows, request log output is formatted as a single line without line breaks.









To view job request logs:

	
Search for the relevant job requests as described in Section 4.2.2.1


	
In the table displaying the job request search results, select the job request whose log you want to view.


	
To view job request details, click the job request ID. Alternatively, click the parent ID associated with the job request to view the details of the job set with which the job is associated.


	
In the job request details page, select Action and then select Request Log to display log information for the job request.









6.7.3 Viewing Log Messages for Scheduled Job Requests

You can use the Oracle Enterprise Scheduler log messages page to view logging information regarding scheduled job requests.

To view log messages for scheduled job requests with Fusion Middleware Control:

	
From the navigation pane, expand the farm, and then Scheduling Services.


	
Select the ESSAPP application for the appropriate Managed Server.


	
In the Scheduling Service home page, from the Scheduling Service menu, choose Logs and then select View Log Messages.


	
Search for the relevant log messages using the Date Range, Message Types and Message fields. You can optionally add additional search fields.


	
You can use the ECID to retrieve more information about a given job request. The Execution Context ID (ECID) is a global unique identifier of the execution of a particular request in which the originating component participates. You can use the ECID to correlate error messages from different components


	
By default, when view the logs for a request, Fusion Middleware Control displays only messages logged in the scope of the Oracle Enterprise Scheduler cluster. If the Oracle Enterprise Scheduler application is not deployed to a cluster, Fusion Middleware Control displays the messages logged in the managed server scope. However, Oracle Enterprise Scheduler propagates the ECID associated with the job request across sub-systems such as SOA, ADF, and so on.

To view messages logged by other sub-systems, broaden the target scope to display messages logged across the domain or farm. Click Broaden Target Scope and select the target whose log messages you want to view.









6.7.4 Setting Oracle Enterprise Scheduler Log Levels

It is possible to configure Oracle Enterprise Scheduler server logging for a Oracle WebLogic Server by modifying the logging.xml file of that Oracle WebLogic Server. By default, there is no explicit logger entry for Oracle Enterprise Scheduler. Oracle Enterprise Scheduler inherits the logging level and log handlers configured for the parent logger, typically the oracle logger or the root logger.

By default, the log messages for the Oracle Enterprise Scheduler logger can be found in the Oracle WebLogic Server diagnostic log file for that Oracle WebLogic Server. The logging.xml file is located under DOMAIN_HOME/config/fmwconfig/servers/WebLogic_Server_Name, where DOMAIN_HOME is the domain home directory for the Oracle WebLogic Server domain and WebLogic_Server_Name is the name of the Oracle WebLogic Server that uses the logging.xml file.

Table 6-8 shows the Oracle Enterprise Scheduler logger names, log levels and a description for each level.


Table 6-8 Loggers and log levels for Oracle Enterprise Scheduler

	Logger Name	Log Level	Description
	
oracle.as.ess

	
SEVERE

	
Problems encountered by Oracle Enterprise Scheduler runtime in the context of request processing that result in the request errors. Errors include exceptions thrown by the job code, unchecked exceptions when running the job code and exceptions when running Oracle Enterprise Scheduler code.

Problems encountered by Oracle Enterprise Scheduler runtime outside the context of request processing, such as dispatching, system event handling, and so on.


	
	
WARNING

	
Less severe problems encountered by Oracle Enterprise Scheduler runtime during or outside of request processing, which might not cause requests to enter error state.


	
	
INFO

	
Messages for request state transitions.

Messages related to work assignment activities.

Messages about batch delete failures.

Start and stop of Oracle Enterprise Scheduler resource adapter.


	
	
CONFIG

	
Application endpoint activation and de-activation for Oracle Enterprise Scheduler resource adapter.








	
Request Logging: Oracle Enterprise Scheduler job implementation might write business-specific job request execution log information to the job request log file. This log file is specific to each request, and is automatically enabled by default. For more information about viewing the log file for a job request, see Section 6.7.2.




For information about setting the log levels for Oracle WebLogic Server, see Section 6.7.5.

Set the log levels for the Oracle WebLogic Server running Oracle Enterprise Scheduler as described in the Oracle WebLogic Server documentation.






6.7.5 Tracing Oracle Enterprise Scheduler Jobs

Enabling tracing for Oracle Enterprise Scheduler jobs provides additional information regarding job requests, which can then be relayed to Oracle technical support to help solve any Oracle Enterprise Scheduler-related issues.

This section contains the following topics:

	
Navigate to the Specify Loggers Region


	
Define the Loggers


	
Attach the Loggers


	
Download the Trace File





Before You Begin

Before enabling tracing, note that tracing log messages may produce a considerable amount of output. By default, traces go to the Oracle WebLogic Server console stdout. If the stdout is re-directed to a file, it may occupy a significant amount of disk space and possibly affect server performance.

To enable tracing for Oracle Enterprise Scheduler jobs:


	
	Task 1   Navigate to the Specify Loggers Region
	
Navigate to the Log Configuration pane and expand the Specify Loggers region.

	
In Fusion Middleware Control, in the navigation pane, select WebLogic Domain and then select the domain and server names.


	
Click the WebLogic Server menu and select Logs and then select Log Configuration.

The Log Configuration pane displays.


	
In the Log Levels tab, from the View dropdown list select Loggers with Persistent Log Level State. Expand the Specify Loggers region toward the bottom of the pane.





	
	Task 2   Define the Loggers
	
Create the following loggers: oracle.as.scheduler.security.internal.SecurityExecutorFactory and oracle.as.scheduler.security.internal.SecurityHelper.

	
In the Name text field, enter the name of the logger.


	
From the Oracle Diagnostic Logging Level (Java Level) dropdown list, select the desired logging level.


	
Repeat for the second logger name.





	
	Task 3   Attach the Loggers
	
Attach the loggers to the Oracle Diagnostic Logging Handler.

	
In the Log Configuration pane, click the Log Files tab.


	
From the list of handlers, select odl-handler and click Edit Configuration.


	
From the Loggers to Associate dropdown list, select the loggers you created and click OK.





	
	Task 4   Download the Trace File
	
Download the trace file.

	
In Fusion Middleware Control, in the navigation pane, select WebLogic Domain and then select the domain and server names.


	
Click the WebLogic Server menu and select Logs and then select View Log Messages.

The Log Messages pane displays.


	
In the Search field, expand the Selected Targets region and select the relevant Oracle Enterprise Scheduler target.


	
Select the relevant date range, message type and so on, and click Search.


	
From the list of log messages that displays, select the relevant message.


	
In the Log File column, click the name of the log file.

The View Log File pane displays.


	
Next to the name of the log file, click Download to download the file.












6.7.6 Saving Job Request Logs

It is possible to save job request log data to the server log file. Job request logs are normally stored to Oracle WebCenter Content. However, when setting the log level to FINER, all job request logs are copied to the server log file.

To save job request logs to the server diagnostic file:

	
In Fusion Middleware Control, in the navigation pane, select WebLogic Domain and then select the domain and server names.


	
Click the WebLogic Server menu and select Logs and then select Log Configuration.

The Log Configuration pane displays.


	
In the Log Configuration pane, click the Log Levels tab.


	
In the Search text field, search for oracle.as.scheduler. and find the oracle.as.scheduler.security.internal.SecurityExecutorFactory logger.


	
Set the log level to FINER and click Apply.


	
Run a diagnostic test, as described in Oracle Fusion Middleware Administrator's Guide. The log messages are now saved to the <server>-diagnostic.log file.

The logs are saved to the server diagnostic file, <Oracle Enterprise Scheduler server name>-diagnostic.log.











6.8 Managing Alerts for Oracle Enterprise Scheduler in Cloud Control

Cloud Control enables you to configure, view and manage alerts for Oracle Enterprise Scheduler entities including the scheduling service itself, work assignments and job definitions. Alerts are based on performance metrics for Oracle Enterprise Scheduler. Each metric includes named objects with upper and lower thresholds indicating warning or critical states for that particular metric. For example, you can configure an alert for all job requests that have entered a state of error, such that 10 errors constitute a warning state, and 20 errors a critical state. Once you have configured alerts, you can view any existing alerts as well as any configuration changes made within a specified period of time.

Table 6-9 lists the alerts available for Oracle Enterprise Scheduler.


Table 6-9 Oracle Enterprise Scheduler Alerts

	Alert	Scope	Collected Data	Alert Automatically Cleared?
	
Alert for job requests in ready state and the average wait time for job requests in ready state.

	
Work assignment

	
The number of job requests in ready state and average wait time of the ready job requests by work assignment.

	
No. The alert is only cleared when the number of ready job requests is smaller than the threshold. The same is true for alerts pertaining to the average wait time of a ready job request.


	
Alert for job requests that have entered a state of error.

	
Work assignment

	
The number of job requests that have entered an error state following the last collection.

	
Yes. The alert is automatically cleared if the delta value of the subsequent collection is below the threshold.


	
Alert for long running job requests.

	
Job definition

	
The longest running time of a job request listed by job definition. The data is queried for only those job definitions for which a threshold is specified.

	
No. The alert is cleared when the long running request transitions to another state.


	
Alert for job requests that have gone to a state of ERROR_MANUAL_RECOVERY.

	
Scheduling service

	
The number of job requests in a state of ERROR_MANUAL_RECOVERY.

	
No. An administrator must recover the job request in order to clear the alert.


	
Alert for timed out job requests.

	
Scheduling service

	
The number of timed out job requests.

	
No. An administrator must cancel or recover the job request in order to clear the alert.


	
Alert for job requests that have gone into ERROR state.

	
Scheduling service

	
The number of job requests that have gone into ERROR state during the last hour.

	
Yes. The alert automatically clears if the delta value in the subsequent collection is below the threshold.


	
Alert for blocked job requests.

	
Scheduling service

	
The number of job requests in BLOCKED state.

	
No. An administrator must cancel the job request, or the job request must be selected for processing in order to clear the alert.








This section contains the following topics:

	
Configuring Metric Alerts for Oracle Enterprise Scheduler in Cloud Control


	
Viewing Alerts for Oracle Enterprise Scheduler in Cloud Control






6.8.1 Configuring Metric Alerts for Oracle Enterprise Scheduler in Cloud Control

You can configure the thresholds for each object monitored by the metric. For a given metric, you can configure alert rules as follows:

	
Select an object that the metric monitors, such as job requests in an errored state.


	
Configure the values at which the object reaches warning and critical states, including an operator value such as greater than (>) or less than (<).


	
Enter a corrective action to be taken in the event that the alert criteria are fulfilled.


	
Arrange the alert rules in the order you desire.




To configure metric alerts for Oracle Enterprise Scheduler in Cloud Control:

	
Navigate to the scheduling service.

	
From the Targets menu, choose Middleware.


	
Navigate to the Oracle Fusion Middleware farm with Oracle Enterprise Scheduler deployed.


	
In the Target Navigation pane, click the name of the domain where Oracle Enterprise Scheduler is deployed, and then click Scheduling Services.





	
Click the Oracle Enterprise Scheduler cluster or an individual Oracle Enterprise Scheduler server.


	
From the Targets menu, select Monitoring and then click Metric and Collection Settings.

A list of metrics displays.


	
Select the metric for which you want to configure alert thresholds and click the Edit icon. For example, you can configure the thresholds for the Average Wait Time for Requests in Ready State (in seconds) metric.

The Edit Advanced Settings page displays, including the Monitored Objects list.


	
In the Edit Advanced Settings page, click Add to add a row to the list of monitored objects.


	
Select the object you want to monitor.

	
In the Name field of the new row, click the Search button.

The Search and Select Objects window displays.


	
Search for the object you want to use and click Select.





	
In the spaces provided, enter the values to be used for the Critical and Warning thresholds.


	
Click Continue, then click OK to save your settings.


	
Configure any additional thresholds as required.




For more information about configuring alerts, see the following topics in the Cloud Control online help:

	
"Incident Rules—Common Tasks"


	
"Incident Rules—Advanced Tasks"









6.8.2 Viewing Alerts for Oracle Enterprise Scheduler in Cloud Control

The Oracle Enterprise Scheduler Service home page displays a summary of alerts. You can navigate to the Incident Manager page to view additional information about incidents by clicking the number of incidents displayed in the Monitoring and Diagnostics area.

To view alerts for Oracle Enterprise Scheduler with Cloud Control:

	
Navigate to the scheduling service.

	
From the Targets menu, choose Middleware.


	
Navigate to the Oracle Fusion Middleware farm with Oracle Enterprise Scheduler deployed.


	
In the Target Navigation pane, click the name of the domain where Oracle Enterprise Scheduler is deployed, and then click Scheduling Services.





	
Click the Oracle Enterprise Scheduler cluster or an individual Oracle Enterprise Scheduler server.

The Scheduling Service summary page displays. The Monitoring and Diagnostics pane displays the following information.

	
Incidents: The number of incidents that have occurred in the scheduling service instance displays here. The number of incidents is determined by those incidents collected as a result of configuring job request alerts. For more information about configuring job request alerts, see Section 6.8.1. If the number of incidents is greater than zero, click the number for more information about the incidents that have occurred.


	
Descendant Target Incidents: The number of incidents that have occurred anywhere in the scheduling service cluster displays here. If the number of incidents is greater than zero, click the number for more information about the incidents that have occurred.


	
Configuration Changes: The number of changes that have been made to alert configurations displays here. Click the number of configuration changes to search for the changes made within a particular period of time. The default time period is seven days.





	
Click the number of incidents to display detailed information about the alerts in the Incident Manager pane.
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The Incident Manager displays incidents in a table, with the following information listed for each incident: severity, summary, target, priority, status, last updated, owner, acknowledged, escalated, type and category.

You can click an incident to display its details. For more information about using Incident Manager, see the following topics in the Cloud Control online help:

	
"Incident Manager—Common Tasks"


	
"Incident Manager—Advanced Tasks"















High Availability for Oracle Enterprise Scheduler







A High Availability for Oracle Enterprise Scheduler


This chapter describes how you can configure and manage a highly available Oracle Enterprise Scheduler environment.

This appendix includes the following topics:

	
Introduction to High Availability for Oracle Enterprise Scheduler


	
Oracle Enterprise Scheduler Concepts


	
Configuring High Availability for Oracle Enterprise Scheduler


	
Managing an Oracle Enterprise Scheduler Cluster






A.1 Introduction to High Availability for Oracle Enterprise Scheduler

A highly available cluster of Oracle Enterprise Scheduler servers is recommended for optimal job performance. This is especially useful for running asynchronous jobs remotely, which may require returning a status message upon completion.

For example, suppose an asynchronous ADF Business Components job runs remotely. Oracle Enterprise Scheduler expects the job to send a status upon completion using a web services callback. If Oracle Enterprise Scheduler runs on only one node, if that node is down, the callback message does not arrive and the status of the job is unknown. The job would then require manual intervention to mark its status as complete.

A two node cluster, however, allows all callbacks to process and arrive at their destination even if one server is down. A clustered Oracle Enterprise Scheduler environment allows callbacks to be delivered as required, and jobs to complete with the correct status automatically assigned by the system.

The main steps required for configuring a highly available Oracle Enterprise Scheduler environment are as follows:

	
Use the Configuration Wizard to set up a domain and configure a cluster.


	
Add nodes to the cluster as required in order to enhance scalability, allowing more processing power for jobs.

When a cluster node is added, the new node's processor configuration might have to be adjusted to assign appropriate work assignments.

For more information, see the Oracle WebLogic Server documentation.


	
Configure the load balancer. For more information, see the Oracle HTTP Server documentation.







	
Note:

For information about troubleshooting an Oracle Enterprise Scheduler cluster, see Chapter B.














A.2 Oracle Enterprise Scheduler Concepts

In order to configure an Oracle Enterprise Scheduler environment, it helps to understand concepts such as the architecture of Oracle Enterprise Scheduler, its components and life cycle.

This section includes the following topics:

	
Oracle Enterprise Scheduler Architecture


	
Oracle Enterprise Scheduler Components


	
Oracle Enterprise Scheduler Life Cycle


	
Oracle Enterprise Scheduler Life Cycle Tools






A.2.1 Oracle Enterprise Scheduler Architecture

Oracle Enterprise Scheduler is installed to an Oracle WebLogic Server instance, on which it runs. The Oracle Enterprise Scheduler service component sits on top of Oracle JRF and is secured by Oracle Web Services Manager. Oracle Enterprise Scheduler manages scheduled job submissions and job definitions.

Figure A-1 shows the Oracle Enterprise Scheduler run time architecture in the context of Oracle Fusion Middleware components.


Figure A-1 Oracle Enterprise Scheduler Run Time Architecture
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The components of the Oracle Enterprise Scheduler run time architecture are as follows:

	
Oracle Enterprise Scheduler client applications: Various applications can request the execution of a scheduled job. Applications include Oracle Fusion applications, Web service clients such as SOA or Oracle ADF Business Components and PL/SQL applications.


	
Oracle Enterprise Scheduler: Fusion Middleware Control enables you to manage Oracle Enterprise Scheduler clusters, services and jobs. Oracle Enterprise Scheduler accesses metadata using MDS. Scheduled job output is saved to Oracle WebCenter Content. Oracle Enterprise Scheduler includes interfaces and APIs that enable interaction with applications and external components. For example, a PL/SQL client uses the Oracle Enterprise Scheduler PL/SQL API to request a scheduled job.


	
Components accessed by Oracle Enterprise Scheduler: Oracle Enterprise Scheduler supports creating Java jobs that access SOA components, Oracle ADF Business Components services, and Oracle Business Intelligence Publisher (there is no direct support for jobs specific to these components).




Client applications accessing EJBs connect to Oracle Enterprise Scheduler over RMI, whereas client applications using Oracle Enterprise Scheduler web services use HTTP. Connections from client applications to the server are persistent, short-lived asynchronous interactions that sometimes use callback functions.






A.2.2 Oracle Enterprise Scheduler Components

Oracle Enterprise Scheduler components are as follows:

	
Oracle ADF Server (Oracle Enterprise Scheduler client): RuntimeServiceEJB and MetadataServiceEJB are deployed as shared libraries. These libraries are imported in the ADF client applications (ears).


	
Oracle Enterprise Scheduler Server (Oracle Enterprise Scheduler Runtime): The Oracle Enterprise Scheduler service component manages all scheduled jobs.


	
Core runtime: This is an Oracle Enterprise Scheduler application EAR file which contains a JCA resource adapter, multiple EJB components and JRF web service modules (WAR files).


	
Hosting applications: A hosting application is an EAR file that imports the ESSEndpointMDB, RuntimeServiceEJB and MetadataServiceEJB shared libraries. An Oracle Enterprise Scheduler hosting application submits job requests using the Oracle Enterprise Scheduler libraries or an integrated job request submission interface.


	
Oracle Database Scheduler: The standard Oracle Database Scheduler is used to execute Oracle Enterprise Scheduler PL/SQL jobs.


	
Oracle Enterprise Scheduler uses Java process APIs to spawn native binary jobs.




Oracle Enterprise Scheduler relies on the following data sources:

	
Oracle Enterprise Scheduler runtime (XA)


	
Oracle Enterprise Scheduler runtime (non-XA)


	
Oracle Enterprise Scheduler Metadata Store (non-XA)




An XA transaction, in the most general terms, is a global transaction that may span multiple resources. A non-XA transaction always involves just one resource, and generally cannot participate in a global transaction.

External dependencies include a run-time database, an MDS repository, as well as Oracle SOA Suite, Oracle ADF Business Components, Oracle BI Presentation Services, Oracle WebCenter Content and so on, depending on the components involved in implementing a given job.






A.2.3 Oracle Enterprise Scheduler Life Cycle

The Oracle Enterprise Scheduler engine starts up as part of the standard J2EE application initialization by Oracle WebLogic Server. The Oracle Enterprise Scheduler JCA adapter connects to the run-time schema and polls for scheduled work items.

The following is the sequence of the execution of a client request in Oracle Enterprise Scheduler.

	
A client application submits a job request.


	
The client application sends the job request to Oracle Enterprise Scheduler.


	
Oracle Enterprise Scheduler reads the metadata for the job request.


	
Oracle Enterprise Scheduler places the job request and the job metadata in a queue in the Oracle Enterprise Scheduler run-time data store.


	
Based on schedule and request processor availability, Oracle Enterprise Scheduler sends a message to the hosted application, which includes all the job request parameters and metadata captured at the time of submission.


	
The hosting application executes the job and returns a status. Job output and logs are written to Oracle WebCenter Content.


	
Oracle Enterprise Scheduler updates the history with the job request status.




Figure A-2 shows the changes in job state during the life cycle of an executed job request.


Figure A-2 Job Request Changes in State During Run Time
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Figure A-3 displays the changes in state for an executable job request for which the executing user has canceled the request.


Figure A-3 Changes in Job State Following Cancellation
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Figure A-4 displays state transitions for a job request submitted with a schedule.


Figure A-4 State Transitions for a Job Request Submitted with a Schedule

[image: Changes in state for a job submitted with a schedule]







A.2.4 Oracle Enterprise Scheduler Life Cycle Tools

As Oracle Enterprise Scheduler runs on an Oracle WebLogic Server instance, you can manage Oracle Enterprise Scheduler using Oracle Fusion Middleware Node Manager for SOA.

Oracle Enterprise Scheduler jobs can be hosted on the same Oracle WebLogic Server instance (or a remote Oracle WebLogic Server instance), database and binary processes. Oracle Enterprise Scheduler controls the life cycle of Oracle Enterprise Scheduler jobs. Use Oracle Enterprise Manager to monitor and manage Oracle Enterprise Scheduler jobs. For more information about managing Oracle Enterprise Scheduler jobs, see Chapter 4.

For more information about Oracle Fusion Middleware Node Manager, see the chapter "Using Node Manager" in Oracle Fusion Middleware Node Manager Administrator's Guide for Oracle WebLogic Server.








A.3 Configuring High Availability for Oracle Enterprise Scheduler

In order to enable a highly available environment, it is recommended to run Oracle Enterprise Scheduler in a cluster of at least two nodes.

This section includes the following topics:

	
Oracle Enterprise Scheduler Configuration and Deployment Artifacts


	
Oracle Enterprise Scheduler Logging


	
Oracle Enterprise Scheduler Cluster Architecture


	
Failover Requirements


	
Scalability


	
Backup and Recovery


	
Load Balancing






A.3.1 Oracle Enterprise Scheduler Configuration and Deployment Artifacts

Configuration files are as follows:

	
ess.xml: This file is part of the Oracle Enterprise Scheduler EAR file deployed to the Oracle Enterprise Scheduler cluster.


	
MDS repository: The Oracle Metadata repository stores Oracle Enterprise Scheduler job metadata. Oracle Enterprise Scheduler supports both database and file-based MDS repositories.




Deployment artifacts are as follows:

	
J2EE application for core run-time and hosting applications.


	
Job metadata within Oracle MDS for core runtime and jobs loaded at startup.




The Oracle WebLogic Server deployment is non-staged.






A.3.2 Oracle Enterprise Scheduler Logging

Use standard Oracle WebLogic Server logging for an Oracle Enterprise Scheduler cluster. Use logs in Oracle WebCenter Content to examine Oracle Enterprise Scheduler behavior. Oracle Enterprise Scheduler logging is configured by default in Oracle WebLogic Server.

The default location for log files for Oracle Enterprise Scheduler process jobs on UNIX servers is /tmp/ess/requestFileDirectory. Oracle Enterprise Scheduler operational log files can be found under <DOMAIN_HOME>/servers/<SERVER_HOME>/logs/<server name>-diagnostic.log, and <MW_HOME>\user_projects\domains\<DOMAIN_HOME>\servers\<SERVER_HOME>\logs\<server name>-diagnostic.log on Windows.






A.3.3 Oracle Enterprise Scheduler Cluster Architecture

Figure A-5 is an architectural diagram of a two node Oracle Enterprise Scheduler cluster.


Figure A-5 Oracle Enterprise Scheduler Two Node Cluster
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This configuration includes the following components:

	
Hardware load balancer.


	
A cluster of Oracle WebLogic Servers running on two servers.


	
Two Oracle Fusion Middleware homes running on two servers.


	
A two node cluster of Oracle Enterprise Scheduler instances, each running on a different instance of Oracle Fusion Middleware.


	
A cluster of Oracle RAC databases with multi-DS configuration is required for availability of run-time and MDS schemas. Multi-DS and Oracle RAC provide for database failure.


	
Shared persistence storage


	
A Metadata Store


	
An HTTP load balancer is required for web service interactions.




For more information regarding high availability architectures, see "Configuring High Availability for Oracle Fusion Middleware SOA Suite" in the Oracle Fusion Middleware High Availability Guide.






A.3.4 Failover Requirements

An HTTP load balancer provides load balancing so as to re-route requests in the event of node failure. There are no time out requirements for the load balancer or firewalls, as long as components use persistent connections. Likewise, session state replication and failover are not required.

Load balancing is used for actions such as submitting a job and querying its status using the Oracle Enterprise Scheduler web service interface. This load balancing occurs independently of where the job is scheduled to execute.

As Oracle Enterprise Scheduler does not use JMS, no JMS failover is needed. Oracle Enterprise Scheduler uses stateless session beans and JCA RAR files rather than stateful session beans. Therefore, no EJB state failover is required.

This section contains the following topics:

	
Request Processor Failover


	
External Component Failover






A.3.4.1 Request Processor Failover

Oracle Enterprise Scheduler includes a request processor component, which represents a single Managed Server in the Oracle Enterprise Scheduler cluster. Request processors process job requests, such that job execution is connected to one or more request processors.

If all jobs are targeted at a number of request processors, jobs are not dependent on a particular request processor. If a job is targeted at a particular request processor, any jobs tied to that request processor execute only when the Managed Server is available and an active workshift exists for the job.






A.3.4.2 External Component Failover

Oracle Enterprise Scheduler interacts with Oracle Fusion Middleware and other components such as Oracle SOA Suite, Oracle ADF Business Components, and so on. If one of these external components fail, it is possible that any running jobs may fail.

You can prevent external component failure from affecting jobs using proper configuration. Table A-1 lists the external components that may fail, along with the steps to take to prevent failed Oracle Enterprise Scheduler jobs.


Table A-1 Oracle Enterprise Scheduler External Component Failover

	External Component	Steps to Prevent Failure
	
Oracle WebCenter Portal


	
Integrate with a cluster of Oracle WebCenter Portal service through a load balancer.


	
Oracle RAC Database

	
Use multi-DS for Oracle RAC database integration.


	
Oracle SOA Suite, Oracle ADF, and so on

	
Configure retries for jobs that depend on these components.














A.3.5 Scalability

Horizontal scalability—adding Managed Servers on different machines—tends to enable better performance than vertical scalability—(adding Managed Servers on the same machine.

Use standard Oracle WebLogic Server cluster scaling methodologies for horizontal scaling. For more information about Oracle WebLogic Server clustering, see the "High Availability for WebLogic Server" chapter in the Oracle Fusion Middleware High Availability Guide. You can increase the concurrent processing of jobs within a work assignment by increasing the thread allocation of the request processor (by editing the workshift for the request processor) or by binding the work assignment to more than one request processor. For more information, see Section 5.3.2.1 and Section 5.3.1.1.






A.3.6 Backup and Recovery

Following are the backup and recovery guidelines for various components:

	
Components stored on the file system: Product binaries, deployed application EAR files and standard Oracle WebLogic Server files in the domain root.


	
Changes to the file system: The file system artifacts change when new EAR files are deployed or when the product is patched.


	
Data stored in the database: The database stores all metadata and run-time data.


	
Changes to database artifacts: Metadata changes when metadata is created and deployed from Oracle JDeveloper or Fusion Middleware Control. Run time data changes when jobs are submitted, undergo state changes, and so on.




There is no consistency requirement between the artifacts stored on the file system and those in database. The file system stores EAR files and temporarily stores scheduled job output and log files.






A.3.7 Load Balancing

Per Oracle best practice, use any hardware load balancer to load balance two or more Oracle HTTP servers, which, in turn, load balance the Oracle WebLogic Server Managed Servers in the cluster.








A.4 Managing an Oracle Enterprise Scheduler Cluster

Managing an Oracle Enterprise Scheduler cluster involves starting the cluster, propagating configuration changes throughout the cluster, deploying applications and handling unexpected behavior.

This section contains the following topics:

	
Starting and Stopping the Cluster


	
Propagating Configuration Changes to the Cluster


	
Deploying Applications to the Cluster


	
Failures and Expected Behavior






A.4.1 Starting and Stopping the Cluster

Oracle Enterprise Scheduler uses standard J2EE components. As such, Oracle WebLogic Server determines the startup sequence. Oracle Enterprise Scheduler also allows implementing throttling to prevent surges in load.

When stopping a cluster, Oracle Enterprise Scheduler and all local Java jobs terminate. Oracle Enterprise Scheduler also attempts to stop all local binary jobs. However, asynchronous jobs such as SOA or PL/SQL jobs will continue. The asynchronous callback from SOA or Oracle ADF Business Component services cannot be delivered if the entire Oracle Enterprise Scheduler cluster is down.

In the case of an abrupt shutdown, the server attempts to recover any on-going transactions.






A.4.2 Propagating Configuration Changes to the Cluster

There are two types of configuration: container or server, and job metadata configuration. Job metadata is stored in Oracle Metadata Repository. The process of configuring the server is the same as that of configuring a standard Oracle WebLogic Server, as part of platform configuration maintained by the Oracle WebLogic Server Configuration Framework. Job metadata configuration changes are deployed from Oracle JDeveloper.

At the cluster level, any configuration changes are propagated by deploying EAR files or metadata. Configuration data is stored either in the database or an EAR file. You can modify the configuration files in the EAR file, such as ess-config.xml, using the MBean browser in Fusion Middleware Control.

Cluster members are independent, sharing only the database. There is no communication among members of a cluster.






A.4.3 Deploying Applications to the Cluster

Applications are deployed to the cluster using standard Oracle WebLogic Server EAR files, using standard J2EE defined Oracle WebLogic Server mechanisms. EAR files can be deployed without restarting the server.

An application deployment includes an EAR file, which contains a JAZN and MAR file. The JAZN file, which contains access privileges for the scheduled jobs, is stored in LDAP under the control of Oracle Authorization Policy Manager. The MAR file contains metadata, and is stored in MDS. Oracle WebLogic Server deploys the application EAR file to all Managed Servers in the cluster.






A.4.4 Failures and Expected Behavior

In the event of failure, the main way to ensure the continuation of job processing is to configure a cluster of Oracle Enterprise Schedulers. If a server fails, another node in the cluster transitions all jobs running on the failed server to the relevant state. Synchronous jobs for example, end in an error state and may be retried depending upon whether retries are configured.

In order to enable high availability for the data tier, use Oracle RAC.

This section contains the following topics:

	
Retries


	
Death Detection and Restart


	
Oracle Java Transaction API Migration and Oracle Java Message Service






A.4.4.1 Retries

You can configure retries for jobs and job time outs for asynchronous jobs. For more information about configuring retries and time-outs for a job, see Section 4.2.1.1.






A.4.4.2 Death Detection and Restart

In order to enable death detection and recovery, each Oracle Enterprise Scheduler cluster node updates its record in the database every minute. This is called a heartbeat. Other nodes monitor the heartbeat, and when the record does not change for a period of time, the server is assumed to be dead. When a server death is detected, each job running on that server is handled. Synchronous jobs are marked as completed with errors, whereas asynchronous jobs continue to run remotely. If retry has been configured, the job marked as completed with errors restarts. Death detection tends to take about ten minutes.

On death detection, the output and log files of a node must be accessible from another node. As such, the file directory containing the job output and log files must be located on a shared file system. This directory is listed in the file ess-config.xml.






A.4.4.3 Oracle Java Transaction API Migration and Oracle Java Message Service

Oracle JTA migration is not necessary for Oracle Enterprise Scheduler.

Oracle Enterprise Scheduler does not use Oracle Java Message Service (JMS) such that JMS recovery is not needed.
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